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1. 基本原理 

1.1 系統結構圖示意圖  

                 
 

          
 

 

離子源：產生離子化，並將產生的離子在電場的作用下進入毛細管。 

毛細管：離子導入通道，將離子源產生的離子傳輸進入質譜。同時，隔離外部的常壓與質譜內部的

高真空。6470為單孔毛細管，6495為六孔毛細管。 

離子漏斗（6495）：通過高壓、低壓兩個離子漏斗，除去溶劑和中性分子，並將離子導入到離子光

學單元。 

離子光學元件：包括 Skimmer 1（6495 沒有），八極柱以及 Lens 1。進一步除去溶劑和中性分子，高

效的離子傳輸組件，並聚焦隨機運動的離子進入四極柱。 

四極柱 1(MS1)和四極柱 2 (MS2)：質量分析器，雙曲線的四極柱優化離子傳輸和質譜分辯率。可以選

擇讓某些質荷比的離子依次通過或者所有的離子全通過。 

碰撞池（CC）：線性加速的高壓碰撞池。優化質譜/質譜分裂，從而在一個短的駐留時間仍可消除交

叉干擾。六極柱設計有助於捕獲碎片離子。90度彎曲設計，可以降低噪音，從而可以增強信噪比。 

檢測器：包括 HED 和電子倍增器。高增益，壽命長，線性範圍寬。新的設計，可以顯著增加信號強

度。 

三重四極柱的真空系統由: 

1) 6470有一個，6490有兩個 Agilent MS40+前級真空泵， 

前級真空 6470一般在 1.0-2.0 Torr之間，6495一般在 1.5-3.5torr之間。 

2) 分子渦輪泵，兩個分子渦輪泵。  

       高真空，不同型號的三重四極柱範圍不同，見下圖列表: 
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型號 6470A 6495A 

碰撞氣關閉時高真空範圍 3 to 6 × 10-6 Torr 1.5 to 3.0 × 10-6 Torr 

碰撞氣打開時高真空範圍 3.2 to 3.8 × 10-5 Torr 3.0 to 3.5 × 10-5 Torr 

 

 

1.2 四極柱質量分析器的基本原理  

四極柱分析器由四根棒狀電極組成，它們距離相等而且互相平行，這四個棒狀電極形成一個四

極電場。四極柱處於對角位置的兩根桿被連接在一起，其中一對桿之間施加電壓(𝑉𝑑𝑐 + 𝑉𝑟𝑓)，同時

在另外一對桿上施加大小相同、極性相反的直流電壓和相位相反、振幅/頻率相同的射頻電壓-(𝑉𝑑𝑐 +

𝑉𝑟𝑓)。 Vdc為直流電壓，Vrf為射頻電壓。直流電壓與射頻電壓疊加在一起，且兩對電極的極性不停進

行快速切換，使得帶電離子震盪通過四極柱。下圖是這種分析器的示意圖。 

 

 

離子在四極柱內的運動軌跡可以用馬修方程來描述。具體的原理可以參考質譜相關的書籍。 

下圖是馬修穩定圖。這是一張 RF 和 DC 電壓結合圖。這張圖可以預測給定的離子在四級桿場中

是否穩定。對於特定的 RF 和 DC 電壓，包含這個曲線之上的穩定區域內的離子將會通過四級桿進入

檢測器。這條掃描線由調機檔中設置的寬度增益和寬度補償決定。如果降低寬度補償，掃描線將會

下降，峰寬度將會加寬。如果掃描線被提高，峰寬度將會變窄。 

+𝑉𝑑𝑐 

+𝑉𝑟𝑓 

−𝑉𝑟𝑓 

−𝑉𝑑𝑐 
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1.3 三重四極柱的工作方式  

每個四極柱質量分析器有三種工作方式：離子全通過（True Total Ion，TTI）、掃描（SCAN）和

選擇離子監測（SIM）。 

離子全通過是指四極柱不施加直流電壓，這樣就不過濾離子，所有的帶電離子全都通過；掃描

是指在給定的質荷比範圍內，依次採集每個質量數的信號；而選擇離子監測模式，只是採集指定的

某個或某幾個質荷比的離子信號。 

兩個四極柱在空間上串聯起來，就可以有多種工作方式。三重四極柱主要有如下幾種操作方

式：全掃描（Scan）、選擇離子監測（SIM，Selected Ion Monitoring）、子離子掃描（Product Ion 

Scan）、母離子掃描 (Precursor Ion Scan)、中性丟失掃描 (Netural Lost Scan)、中性獲得掃描（Netural 

Gain Scan）、多重反應監測 (MRM，Multiple Reaction Monitoring)。 

我們這裡本手冊只介紹最常用的Scan、SIM、Product Ion Scan和MRM這幾種工作方式。下面的內

容可以和方法設置部分質譜的參數設置配合理解。 

1.3.1 掃描（MS2 Scan） 

MS1 工作在離子全通過（TTI）狀態下，不過濾離子，所有的帶電離子全都通過；碰撞池不施加

碰撞能量，不會把離子撞碎；而 MS2 工作在掃描模式，可以得到待分析物質的一級質譜圖。在這種

工作模式下，其功能與單級四極柱類似。 

 

 

1.3.2 選擇離子監測（SIM） 

MS1 工作在離子全通過（TTI）狀態下，不過濾離子，所有的帶電離子全都通過；碰撞池不施加

碰撞能量，不會把離子撞碎；而 MS2 工作在 SIM 模式，可以得到選定的離子的一級質譜圖。在這種

工作模式下，其功能與單級四極柱類似。 

穩定區 

不穩定區 
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1.3.3 子離子掃描（Product Ion Scan） 

MS1 使用SIM 方式選擇某一個或多個特定質荷比的母離子通過四極柱1，在碰撞池施加碰撞能量

產生碎片離子，然後在MS2 中進行掃描分析。此過程可以產生典型的質譜/質譜碎片譜圖。 

     

 

1.3.4 多重反應監測（MRM） 

MS1 採用SIM 方式選擇某個或多質荷比的母離子，在碰撞池產生碎片離子。MS2 同樣採用SIM方

式來監測由母離子產生的一個或幾個特定子離子。這就是多重反應監測（MRM）。這種方式可以極

大提高檢測靈敏度和定量準確性。是三重四極柱儀器最主要的使用方式`。 

     

 

1.4 離子源技術和原理  

安捷倫專利的直角噴霧離子源設計，霧化器與離子傳輸毛細管軸呈 90 度角，這樣大大減少了未

離子化的中性溶劑液滴進入到質譜中，從而降低了噪音，並保證毛細管和離子光路更乾淨，更抗污

染。固定位置的霧化器在分析方法要求改變流速或流動相組成時，無需對霧化器位置進行繁複的調

整，大大提高了分析效率。 

安捷倫的離子源包括高流量的高溫氮氣反吹乾燥氣系統，可以加速噴霧的溶劑揮發，減少溶劑

簇和流動相附加離子，提高了譜圖的質量、靈敏度和重現性。在儀器不進樣分析（處於 Standby 狀態）

時，仍然維持一定的乾燥氣溫度和流量，可以避免用戶實驗室的空氣被吸入質譜的真空系統，極大

的減少了污染，降低了維護的週期。 

 

1.4.1 ESI源—大氣壓電噴霧離子源 

霧化器的噴霧針被帶了高電壓的半圓柱體形電極環繞，帶有被測物質離子的流動相，在霧化針

尖端發生霧化。在半圓形電極和毛細管間的電壓不同，產生一個電場，使液滴表面表富集帶同種電

荷的離子，而內部帶相反電荷聚集，形成帶電液滴細的噴霧，液滴在電場的作用下，飛向毛細管。

加熱的氮氣乾燥氣體的反向流動，帶走液滴中的中性的溶劑分子，從而收縮液滴，直到排斥的靜電
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力超過液滴表面張力，引起庫侖爆炸。 這個過程不斷重複，直到待分析物離子最終變成氣態進入毛

細管。 

 

 

ESI是目前應用最多的電離方式，具有極為廣泛的應用領域。ESI屬於濃度敏感型離子化技術，樣

品濃度越高，靈敏度越高。適合分析中等極性到極性的小分子；另外，由於其可以產生多電荷離子

的特性和相對較低的離子化溫度，因而也適合分析生物大分子，比如蛋白質和多肽的分析。 

 

1.4.2 APCI源—大氣壓化學電離離子源 

APCI的電離是在常壓下的氣態化學電離(CI)過程, 是 ESI電離的一種有效補充。溶劑或反應氣在電

暈針的作用下先帶電，再把電荷轉移給化合物形成離子。APCI 一般只產生單電荷離子，且需要在高

溫的離子化環境下操作。它屬於質量-流量敏感型離子化技術，樣品分子量越大，性能越高；在相對

較高的流速下靈敏度更高。適合分析中等極性到弱極性的化合物。 
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1.4.3 ESI with Agilent Jet Steam Technology—帶有安捷倫噴射流技術的 ESI源 

帶有安捷倫噴射流技術的 ESI 源與普通的 ESI 源的電離原理相同，提供和普通 ESI 源相同的離子

特徵。另外，噴射流技術增加了加熱的鞘流氣，並可以在噴嘴處施加一個噴嘴電壓。更高的溫度可

以提高流動相的蒸發率，更有利於氣溶膠的形成和液滴的蒸發，減少了噴霧中大的液滴。由於使用

了熱梯度聚焦技術，同軸的鞘流氣有助於減少離子擴散，將更多的離子引入到 MS中。減少中性溶劑

束進入 MS，提高了靈敏度，降低了噪音。 

 

 

 

1.5 不同離子源的比較  
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2. 硬體概覽 

2.1 典型配置圖  

整套儀器包括液相層析和質譜主機，以及與其配套的電腦和印表機。電腦、液相層析和質譜之

間通過網路通訊協定通訊，並通過一個網路交換機（LAN Switch）連接在一起。 

 

2.2 儀器序號位置  

對於液相層析，每個模組的型號和序號標籤在該模組的右下方；對於三重四極柱，儀器的型號和序

號標籤在儀器左下角的左側。如下圖所示。所有安捷倫的產品，Gxxxx 代表的是該產品的型號，

USxxxxxxxx，DExxxxxxxx或者 JPxxxxxxxx代表的是儀器的序號。 

                                                    

 

 

 

 

 

 

 

注意：在您撥打 Agilent售後服務電話到時，請事先務必準確記下您故障模組的型號和序號。這對於

我們在系統裡及時給您提供服務非常重要！ 

每個液相模組的右下角可

以找到相應模組的型號和

序號 
儀器右下角可以找到儀器

的型號和序號 
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例如：您液相的泵故障了，請務必告訴我們泵的型號和序號，而不是質譜的型號和序號。 
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3 開機和關機 

3.1 開機步驟  

如果使用液氮罐，打開液氮罐自增壓閥門，調節液氮罐分壓表的輸出壓力為約 0.7 MPa

（~100psi），並確認前級泵的震氣閥處於關閉狀態。 

如果使用氮氣發生器，打開氮氣發生器的電源，待壓力輸出穩定後，調節輸出壓力為約 0.7 MPa

（~100 psi），並確認前級泵的震氣閥處於關閉狀態。 

注意:    不同的氮氣發生器，其操作可能不同。請諮詢氮氣發生器的供應商，以正確操作氮氣發生

器。安捷倫不對因氮氣發生器的原因導致的儀器損壞和故障負任何責任。 

如果使用氮氣發生器，請務必依照相應廠家的建議，定期維護，更換過濾芯等。防止氮氣污

染質譜，影響儀器的性能。 

如果您的氮氣發生器為隨安捷倫的質譜主機一起訂貨的 Peak氮氣發生器，安捷倫的工程師負

責安裝調試，但是售後的維修、維護和技術支援均由 Peak在台灣的代理負責，安捷倫不負責

與氮氣發生器相關的任何質量問題和維修。 

 

        打開高純氮主閥門，調節高純氮氣鋼瓶次級減壓表輸出壓力至 0.15 MPa（最大不要超過 0.2 

MPa）。 

1. 打開電腦，網路交換機（LAN Switch）電源。 

2. 打開液相各個模組電源。 

3. 打開質譜前面左下角的電源開關，這時可以聽到質譜裡面溶劑切換閥切換的聲音。同時機械泵開

始工作，儀器開始自檢。等待大約兩分鐘，聽到第二聲溶劑閥切換的聲音(表明質譜自檢完成)後，

表示儀器自檢完成，可以連線。 

質譜一接通電源，前級真空規就開始工作，監視前級真空值。但只有當 Turbo1 和 Turbo2 渦輪泵的

轉速都大於 95%之後，四極柱的高真空規才會開始工作，正常讀取真空值。 

4. 在電腦桌面上按兩下 MassHunter採集軟體圖示 ，進入 MassHunter工作站。 

 

3.2 關機步驟  

1. 在MassHunter採集軟體內點擊三重四極柱MS的圖示，依下圖所示選擇Vent。 

  點擊 Vent執行放空步驟 
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2. 出現下述提示，如果確認要放空，選擇Yes。 

 

3. 可以在三重四極柱Method的Diagnosis介面觀察渦輪泵轉速的下降情況。 

 

5. 分子渦輪泵轉速和功率基本為0後，等待30分鐘，關閉MassHunter 軟體。然後關閉質譜及LC各模

組，PC的電源。 

 

注意事項 

如果長時間關機的話請拔掉質譜主電源線。 

如果使用液氮罐，同時關閉自增壓閥門。 

如果使用氮氣發生器，關閉氮氣發生器。 

注意：建議不要關閉碰撞氣用的高純氮的減壓閥。儀器關機後，並不會消耗高純氮，但是，這樣可

以使整個管路保持正壓，有效保護高純氮的捕集阱不被環境空氣污染。 
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4. 軟體概覽 

在儀器安裝完成後，工程師一般都會將一些與 MassHunter 工作站相關的圖示放置於電腦桌面上，

便於用戶使用。 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

液相色譜診斷軟體 Lab Advisor  

軟體進程管理

器 

自動優化軟體 

 資料獲取軟體 

 

定性分析軟體 

 

定量分析軟體 

 

離線方法編輯軟體 

 

儀器配置程式 

 

 

儀器配置程式 

 

 

8615

5809

8009

8 

儀器事件記錄本 

 

離線工作清單編輯軟體 

 

強制結束軟體進程 
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4.1 軟體功能區、狀態欄及快捷方式介紹  

採集軟體從上到下分為三個不同的功能區，依次是儀器圖示及狀態欄、離子流圖和質譜圖即時

顯示區、以及方法，工作清單和樣品資訊混合顯示區。 

 

在採集軟體的最頂端有一些快捷按鈕，介紹如下： 

 

 

 

 

 

在鎖定狀態，如果有重名的資料檔案，無法覆蓋，必須使用不同的資料檔案名。在非鎖定狀態，

如果有重名的資料檔案，可以選擇覆蓋原來的檔。 

點擊 Logbook 可以查看詳細的儀器運行資訊和出錯資訊。當儀器出錯時請首先參考 Logbook 的相

關資訊。最頂端的是最近的資訊。 

改變了各個功能區的大小，或者改變了視窗佈局後，如果切換到其他介面或者關閉軟體時，軟

體會提示是否要保存該軟體佈局(Layout) 。這允許不同的使用者依據自己的愛好調整軟體的介面

 

 

 

方法，工作清單和樣品資訊在同一個區

域顯示。通過點擊相應的按鈕切換頁面 

軟體佈局格式選擇 

停止或暫停

儀器運行 
工作列表選擇 

軟體功能區切換 

保存軟體佈局 

運行單針樣品 

運行 Worklist 

鎖定/非鎖定狀態 方法選擇 Logbook 

儀
器
及
狀
態
欄 

即
時
顯
示
區 

參
數
編
輯
區 
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         在 Actuals 處點擊滑鼠右鍵，選擇 setup。在彈出的 Actuals Setup 對話方塊，選擇前級真空、高

真空、乾燥氣流量和壓力以及渦輪泵轉速、毛細管電流等重要參數到即時狀態顯示視窗。對於重要

參數還可以選中該參數，然後點擊 Background Color按鈕和 Text按鈕設定背景及字體顏色等。 

 

  

 

 

在軟體中，儀器模組的不同的顏色代表了儀器的不同狀態： 

 綠色：Ready，表示儀器準備就緒，處於空閒狀態，可以隨時進行樣品分析。 

藍色：表示儀器正在運行樣品。 

紫色：表示儀器處於等待運行的狀態，或預運行狀態。 

黃色：Not Ready，表示儀器的狀態還沒準備好或者儀器條件還沒達到設定值。 

 灰色：表示儀器處於 Standby By或 Shut Down狀態。 

紅色：表示儀器出錯。 
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5. 儀器配置和快捷控制功能 

在儀器的各個模組上，按一下滑鼠右鍵可以彈出快速控制儀器的功能表。 

注意：如果您的儀器的相應模組功能表與下圖所示有所不同，那麼則說明您的某些模組沒有此功能

或者您的軟體版本不支援此功能。 

  

 

         

5.1 自動進樣器的配置和快捷控制功能  

 

注意：定量環、針座以及進樣針的設定必須和儀器的配置相同，否則會影響儀器的性能或進樣體積

錯誤。除非儀器的硬體有更改，否則請不要更改預設的配置。 

每個模組左上角有

一個開關巡鈕，可

單獨控制該模組 

總開關可以控制所

有 LC模組和 QQQ 
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注意：只有配備了自動進樣器控溫元件的時候，才會顯示 Thermostat 頁面。控溫元件可以控制的溫

度是 4-40℃。可以設定這之間的一個任何溫度或者選擇不控制。確保恒溫組件的冷凝水排水管暢通

且中間不存在 U型彎。否則，內部的冷凝水無法排出，會影響其控溫精度，並會損壞控溫組件。 

Injector Program：設定程式進樣，即手動設定自動進樣器一步步做什麼，很少用到。 

Home All：自動進樣器回到 Home位置。 

Reset Injector：自動進樣器重新自檢。 

Switch Valve to Bypass：自動進樣器的進樣閥切換到 Main Pass或 Bypass的位置。 

在默認的操作條件下，除了在進樣的過程中，自動進樣器都是在 Main Pass的流路。這樣的流路

設計使進樣針和針座的內表面一直都在被流動相連續沖洗，最大程度減小了樣品的殘留和交叉污染。 

 
 

 

Switch on Tray Illumination：開關 LED燈。對於怕光的樣品，應該關閉。 

From Pump 

3 

4 
1 

2 

1 

選擇開啟電源時控溫模

組是否立即開始工作 

自動進樣器相關泵的

資訊，包括序號 

 

開關 LED燈 

 

如果工作列表運行過程

中發現某個位置的樣品

瓶找不到，選擇繼續運

行下一個樣品或者停止 

可以設定控溫功能在

某個時間自動開啟 

開啟溫控模組，設定

控溫模組的溫度 

設定何時清空

workspace 

5 

Bypass 

Main pass Flush 
needle 

To Column 
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Switch off /on Tray Illumination: 打開/關閉自動進樣器 LED燈。 

Auto clean: 自動沖洗自動進樣器。 

 

 
 

Prime Solvents：快速排空洗針液流路，並可以設定排空時間。 

Modify： Drawer Configuration 用於配置樣品抽屜 (Drawer)。使用該功能請注意：需要清空

workspace，Drawer 中有兩個樣品託盤(Tray)並且不能有樣品瓶及樣品盤(Plate)，關閉自動進樣器門及

Drawer，點擊 Start 後，軟體會自動識別 Drawer 類型；當配置有多個 Drawer 時第一層 Drawer 分別為

Plate 1(P1) 和 Plate 2(P2)，第二層 Drawer分別為 P3，P4，如果有更多 Drawer，命名以此類推。 Capillary 

Setup用於選擇定量環和針座類型。 

 

 
 

下圖為可選的 Drawer配置。儀器隨機標配 2H Drawer，1H和 3H為選配。通常，1H Drawer用於安

裝微孔進樣板，2H Drawer用於安裝 2 ml 進樣瓶，3H Drawer用於安裝較大的 6ml進樣瓶。 

切換自動進樣器六

通閥 

 

清洗針外壁，並設

置沖洗時間 

 
沖洗流路，及沖洗

時間 
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Assign Wellplates：需要正確設置樣品盤 (Plate) 的類型。 

 
 

下圖是 G7167A/B 型號的自動進樣器的 Tray 示意圖。其中右側樣品盤的是位置 1-5；左側可以根

據儀器配置不同，有多種的組合方式，可以選擇 54 位元樣品盤，還支援 96位等微孔板，可以在 Tray 

and Plate configuration 選項中配置，選擇樣品盤類型時必須使用列表中的微孔板。位置編號規則如下

圖： 

 

P1為底層樣品抽屜前面的

樣品盤，54vialplate 為指定

54為進樣盤 

 

P4為第二層樣品抽屜

後面的樣品盤 
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對於 7129A/B自動進樣器，使用兩個樣品盤 P1和 P2，位置編號規則如下圖 

 

 

 

5.2 二元泵的快捷控制功能  

 

Control：可以控制泵的 On，Off，Standby功能。另外提供了可以設置在某個預設的時間自動打開

運行的功能。 

如右圖示星號的位置，其編號應該為：P2-B4 

P2：表示是第 2個樣品盤，即底層樣品抽屜

(Drawer)後面的樣品盤。 

B：表示為第 2排。 

4：表示為第 4列。 

 

P

1 

P

2 

P

3 

P

4 

如右圖為 P1圖示星號的位置，其編號應該為：P1-D9 

P1：表示是第 1個樣品盤，即進樣器左邊的樣品盤。 

D：表示為第 4列，9：表示第 9排 
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Switch Pump On/Off: 把泵的狀態切換到 On或者 Off。這個功能也可以通過上面的 Control來實現，

或者直接點擊泵圖示的電源按鈕。 

Switch Solvent Selection Valve A: 可以快速切換使用的流動相 A。如果當前使用的是 A1，則可以

快速切換到 A2；反之亦然。 

Switch Solvent Selection Valve B: 可以快速切換使用的流動相 B。如果當前使用的是 B1，則可以快

速切換到 B2；反之亦然。 

Bottle Fillings：設定溶劑瓶的容量以及瓶內實際溶劑的量。並設定如何處理溶劑低於設定量的情

況。 

 
 

如果不啟用“Prevent analysis if level fall below”和“Turn pump off if running out of solvent”，則不需要

設置此介面。如果啟用的話，必須正確設置溶劑的實際體積。每次添加或改變流動相時，必須打開

此介面正確設置各個通道流動相的正確體積。軟體會根據流速的設定自動計算溶劑瓶內剩餘溶劑的

量。不正確設置實際流動相體積時會造成分析意外終止，並會導致報錯。此時重新設定流動相體積

並重新把泵設定到 ON清除錯誤即可。 

Prepare Pump: 用於排掉管路中的氣泡，或者更換不同的流動相時使用。 

各個通道溶劑的實際體
積。如果更換或添加，需
要手動更改其數值。只有
帶溶劑選擇閥的二元泵才
會顯示 A1, A2, B1, B2。 

可以設置泵在預

設的時間自動打

開運行 

設置泵打開、

關閉或待機 

各個通道的溶劑瓶的
體積容量 

 

如果選中此項，則儀器會
自動在計算出的溶劑剩餘
量低於此設定量的時候停
止樣品分析 

如果選中此項，則儀
器會在計算出的溶劑
溶劑剩餘量為零時自
動關閉泵的運行。 
 

設置廢液瓶實際體積及總
容量 

如果選中此項，則儀器會
自動在計算出的廢液瓶高
於此設定量的時候停止樣
品分析 

如果選中此項，則儀
器會在計算出的達到
廢液瓶最大值時自動
關閉泵的運行。 
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注意：如果排氣不徹底，泵頭內殘留有微小的氣泡，則會導致壓力不穩定。如果 Prime 和 Purge都不能使

壓力穩定下來，請嘗試使用甲醇或者乙腈沖洗系統。水有時因為表面張力大，比較難排氣泡 ; 使用

Conditioning 時，請使用分析方法初始流動相梯度，流動相會經過層析柱，產生背壓較高，以清除系統中

微小氣泡，減小壓力波動。 

Seal Wash Prime: 沖洗柱塞清洗流路。柱塞清洗使用 10%的異丙醇水溶液。在 1290 infinity II系統

中，柱塞桿清洗默認打開，且不可迴圈使用異丙醇清洗液。 

 

5.3 柱溫箱的快捷控制功能  

Switch Thermostat On/Off：打開或關閉柱溫箱的控溫功能。 

Control：包含柱溫箱的一些控制功能。 

 
 

5.4 DAD 的快捷控制功能  

Control：包含開燈等功能。另外包含一些其他的控制功能。 

手動打開或者關閉柱溫箱的
控溫功能 

設置電源開啟時是
否自動打開柱溫箱
的控溫功能 

設置預定時間自動
打開柱溫箱的控溫
功能 
 

設置是否打開柱溫箱的漏液
檢測功能。默認打開。但是
如果柱溫箱的設定溫度低於
室溫，且環境濕度比較大，
建議最好關閉。以防冷凝水
的凝結造成誤報 

Purge 用於日常的流動相
排氣泡，在更換流動相或
者每天剛開機的時候使用 

Prime 用於比較劇烈的沖
洗，如果系統中有明顯的
氣泡，在做 Purge 無法除
去時建議使用 

Conditioning 用於減小系統
的壓力波動，使用 LC 方
法，流動相會通過 LC 流
路及色譜柱 

選擇柱溫箱連接的檢測器
類型 
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Balancing：對 DAD檢測器進行基線歸零。 

Switch UV Lamp on/off：選擇打開或關閉紫外燈 (UV Lamp) 。 

 

5.5 VWD 的快捷控制功能  

 

Control： VWD的某些控制和配置選項。 

 
 

Switch On/Off：打開或關閉氘燈。 

Balancing：對檢測器進行基線歸零。 

Calibration：運行波長校正測試。在懷疑波長不準確的時候可以進行測試。 

Balance：對檢測器進行基線歸零。 

Intensity Plot：運行光強度測試。在懷疑燈的能量偏低引起靈敏度降低的時候可以進行測試。 

注意：如果需要運行 Calibration、Intensity Plot和Holmium Test時，一般在 LC Lab Advisor軟體內進行操作，

且必須保證流通池是乾淨的，並充滿水。 

控制氘燈的打開或關閉 

選擇使用的氘燈的類型

一般選自動 

設置在預定的時間自動

開燈 

模擬輸出的設置。設置類

比信號的輸出範圍。只有

在使用協力廠商的軟體控

制時，或使用積分儀記錄

信號時才可能用到 

打開或關閉氘燈 

是否打開 VWD 內置的
溫控。一般選擇打
開，檢測器更穩定 

模擬輸出的設置。設置類
比信號的輸出範圍。只有
在使用協力廠商的軟體控
制時，或使用積分儀記錄
信號時才可能用到 

設置在電源開關開啟
時是否自動開燈 
一般不需要選擇此項 

打開 DAD 的電源開關時

自動打開氘燈。一般不

必選此選項 

設置在預定的時間
自動開燈 

紫外燈 Tag 的識別方
式選擇，選預設自動
模式即可 

流通池 Tag的選擇方式 
默認選擇使用 
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5.6 三重四極柱的配置和快捷控制功能  

 

On，Standby：把三重四極柱設置到開，待機狀態。 

注意：在不做樣時，一般把儀器放置在 Standby狀態。 

Calibrant On：開啟或關閉調機液。開啟時，調機液自動通過霧化器進入 MS。 

Collision Gas On：開啟或關閉碰撞氣。正常操作時必須打開碰撞氣。 

LC→MS或 Waste：從 LC流出的流動相是進入質譜或者廢液桶。需要採集信號時必須流入質譜。不需

要採集資料時可以流入廢液桶。 

Vent，Pump Down：Vent指把 MS的真空系統卸掉，關閉機械泵和渦輪泵的工作；而 Pump Down指把

真空系統開起來，即啟動機械泵和渦輪泵。取決於儀器現在的狀態，二者只有一個可以使用。 
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6. 調機和校正 

調機包括三種方式：自動調機（Autotune）、檢驗調機（ Checktune） 和手動調機（Manual 

Tune），自動調機是一個自動過程，它在整個質量範圍調節三重四極柱的各種參數，使其獲得最優

性能；檢驗調機並不改變質譜的參數，而是調用當前調機檔的參數來採集資料，評價和確認儀器是

否有偏移；手動調機允許用戶手動更改影響質譜性能的各個參數，一般較少使用。 

調機後，被優化、校正過的質譜參數記錄在調機檔中，被保存下來。 

6.1 自動調機步驟  

1.自動調機在三種解析度模式下調節兩個四極柱的參數：Unit（半峰寬 0.7amu)，Wide(半峰寬

1.2amu)和 Widest(半峰寬 2.5amu)。調機步驟如下： 

 

 

 

       2. 左鍵或右鍵點擊三重四極柱圖，選擇 On。 

            

3. 在 Context下拉清單中選擇 Tune，選擇切換到 Tune介面。 

           

 

接下來如果彈出“Do you want to save layout changes?”和“Do you want to save the changes for the current 

method?”提示框，請根據是否需要保存相應的佈局和方法的修改，選擇 Yes或 No。 

       

      

4. 等待三重四極柱的圖示變綠，達到 Ready狀態後： 

1） 如果是 Jet Steam 源，請繼續等待 15-30min，然後再進行調機； 

2） 如果是 ESI 源，無需等待可以直接進行調機。 

5. 點擊Autotune的頁面，主要的參數如下。上部是極性的選擇和自動調機的選項。我們可以選擇對正

極性、負極性分別做調機或者選擇正負極性同時調機。一般情況下，不必選“Both”，只要調機需

要的極性即可。 

Jet Steam源在ON的狀態下切忌直接打開離子源。設置為 Standby後，也務必等待鞘氣溫度下降

至 125度後，才能開打開離子源。否則很容易燒壞鞘氣的加熱元件！ 
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     “Start from factory default” 選項大部分情況不必選擇： 

1） 不選擇此項，調機參數的優化從上次的調機結果開始。 

2） 選擇此項，則自動調機會從工廠默認的參數開始。一般情況下不必選擇。 

 

 

                                     

 

6.點擊 Autotune按鈕，調機液會自動進入質譜，自動調機過程開始。出現下面的標籤時，表示系統正

在平衡碰撞氣和調機液的流量，不要點擊 Continue，系統會自動繼續。 

 

調機過程中，底部會顯示調機進程及正在進行的調機操作。根據軟體版本和儀器型號的不同，每

種極性的調機可能需要15-40分鐘之間。 

 

 

 7. 自動調機結束後，底部顯示調機完成，並自動彈出調機報告。同時，會彈出一個提示框，請點擊

OK按鈕。 

調諧極性選擇 

Positive：正極性 

Negative：負極性 

Both ： 同 時 調 諧

正、負極性 

是否選擇從工廠默認參數

開始調諧，一般不需要 

如果經常需要分析質荷比小

的樣品，可選擇此項。 

產生的調諧報告中會多出一

個 58的離子 

Checktune 的指

標設定區域。 

調諧進度顯示區域 

只做 unit 解析度，節省調

諧時間 
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調機結束後，調機液會自動關閉。調機檔自動會保存為atunes.Tune.xml。同時，每次調機還會自

動生成一個備份的調機檔。這樣，以後可以方便的調用任何一次調機的參數。請通過Context功能表

選擇Acquisition返回到資料獲取介面。 

 

 

注意：四極柱質譜一般非常的穩定，不需要經常進行調機。自動調機週期一般2-3個月即可，或者在

Checktune不能通過時進行。 

 

6.2 檢驗調機的介紹及使用  

檢驗調機Checktune並不改變質譜的參數，而是調用當前調機檔的參數來採集資料，評價和確認

儀器是否有偏移。Checktune 掃描在不同解析度下各個質量數的輪廓圖並與目標值的峰寬和質量軸進

行比較，看是否在設定的運行偏差範圍內。它提供了一個不執行完整的Autotune 而快速確定調機檔

是否合適的方法。 

下圖是默認的質量軸和峰寬的檢驗指標。實際操作中，使用者可以根據自己的工作需要將質量

軸偏差範圍設定到更寬的範圍，比如可以設置到Unit 0.2，wide 0.5 和widest 0.8；將峰寬偏差設定為

Unit 0.2，Wide 0.8和Widest 1.5。 

 

如果Checktune 超出範圍，且有偏差的離子在常用的檢測範圍內，建議進行Autotune 或Manual 

Tune來調整。如果有偏差的離子完全與我們的分析檢測範圍無關，可以忽略，此時完全不會影響分

析的結果。比如，Checktune報告顯示1822離子的峰寬或質量軸的偏差超出允許範圍，但是我們分析

中只需要分析質荷比小於1000的樣品，那這種情況下不必做任何的調整。 

注意：在檢驗調機結果超出允許範圍不大的情況下，如果需要校正回來，除了重新進行自動調機

外，還可使用後面手動調機部分介紹的Adjust Gain & Offset功能。這樣可以節省很多時間。 

點擊Autotune介面下的Checktune，軟體會自動完成檢驗調機過程。Checktune完成後，與Autotune

一樣，也會自動生成調機報告，並提示Checktune已完成。 

 

峰寬的檢驗指標 

質量軸的檢驗指標 



 

版權所有  影印必究 

 

 

 

6.3 手動調機的介紹和使用  

我們現場培訓不講解手動調機的具體原理和操作，這裡只講解一些日常操作中可能會用到的常

見功能。 

如果選擇Calibrant On，則調機液會被壓入質譜。如果需要使用手動調機來觀察標準調機液的離子

的話，必須先手動打開調機液。 

在進行自動調機時，也可以先切換到手動調機介面，打開調機液，待質譜達到 Ready後再切換到自動

調機介面開始自動調機。 

在 Scan Type 下可以選擇質譜的各種操作模式，與資料獲取介面相比，這裡有更多的模式可以選擇，

比如 MS1 Profile，MS1 SIM等。 

 

 

  

 

在檢驗調機部分我們講到有時檢驗調機的結果，某些指標可能會超出了允許的範圍。如果超出

的範圍不大的話，完全可以不重新進行一個費時的自動調機，而是使用Adjust Gain & Offset功能來進

行校正。 

我們可以在Scan Type的下拉式功能表選擇MS1 Profile或MS2 Profile來確定是調整MS1還是MS2，以

及需要調整的極性是正或負，並選擇需要調整的解析度是Unit、Wide或Widest，點擊Adjust Gain & 

Offset按鈕執行即可。調整完成後，會彈出提示，但是不生成報告。 

 

 

 

 

 

 

 

  

手動打開或

關閉調諧液 

 

極性選擇 

 

下列清單選擇質

譜資料獲取模式

選擇 

 

 

 

參數顯示和設置區域，點擊某個專案

的按鈕，則會顯示該功能的所有參數 

離子源參

數區域 

更改某參數後，點擊

Apply按鈕後才會應用 

點 Acquire 按鈕，才能

看到離子的採集結果 
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下拉 選 擇需 要 調整

Unit、Wide或Widest解

析度的結果 

點擊此按鈕開始執

行 

下拉選擇需要調整 MS 或 MS2，相

應選擇 MS1 Profile或 MS2 Profile 
極性選擇 
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7. 方法編輯 

方法是進行樣品分析的 LC、MS 的參數的集合，以及分析某個特定樣品所需的前運行和後運行任

務。下面我們對方法的建立的詳細步驟進行講解。 

在桌面上按兩下資料獲取軟體圖示 ，打開 MassHunter 採集軟體，進入 MassHunter 資料獲

取軟體。在左上角的 Context下拉式功能表確認在 Acquisition介面，在這個介面中完成所有 HPLC和三

重四極柱的方法參數設置。 

 

 

7.1 新建方法  

在採集軟體介面左下角點擊 Method Editor，在此處編輯所有 LC和 QQQ的方法參數。 

 

 

 

             

 
 

 

7.2 液相參數設置  

7.2.1自動進樣器方法的設置 

7.2.1.1 G7167A/B Multisamlper自動進樣器的方法設置 

注意：如果您使用的是 G7129型號的自動進樣器，請忽略此部分內容。 

可以設置進樣方式，進樣體積等。Injection Volume處來設置進樣體積。如果在樣品資訊或者工作

清單(worklist)中設置了進樣體積，那麼這裡設置的進樣量會被忽略，而採用樣品資訊或者工作清單中

的設置。 

為了減少交叉污染和進樣殘留，進樣方式一般選擇洗針進樣。可以使用標準洗針（Standard 

Wash），在 Injection Path Cleaning功能表中可以設置 Standard Wash 參數；洗針方式可以使用某個固

可以給方法添

加一些注釋 

方法另存為 方法報告 當前調用的方法。下拉可以

顯示最近使用過的方法列表 
撤銷對方法參數的更改 

更改參數後，點擊

Apply按鈕才會應

用到儀器。 

可以設定方法運行前後

的操作。比如方法運行

完後儀器自動 Standby 

可以給方法添

加一些注釋 

方法的保存路

徑以及名稱 

新建方法 

打開已有的方法 

保存方法 
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定位置的樣品瓶（Wash vial），也可以使用清洗埠洗針（Flush Port）。相對來說使用清洗埠可以取得

更好的洗針效果。一般都選擇這種模式，清洗時間 3-10秒鐘就足夠了。 

 

          
 

取樣位置可以調整進樣針的插入位置，默認為零。使用標準樣品瓶時針尖距離瓶底的距離約為

5mm。當樣品量比較多並且擔心有沉澱的時候，可以選擇把針的位置抬高（最多比默認位置抬高

5mm）。當樣品量很少時，也可以考慮把進樣針的位置降低（最多比默認位置降低 5 mm）。 

注意：如果設置降低針的位置的時候，請特別小心操作，每個自動進樣器可以降低的數值是不一樣

的，防止降得過低紮壞樣品瓶，損壞進樣針和自動進樣器。在使用內插管的時候，最好不要使用 Bottom 

Sensing的功能。請選用安捷倫標準進樣瓶。 

      
 

對於安裝有 Multi-Wash 功能的 G7167 自動進樣器，還可以選擇 Seat Backflush 功能來反沖針座，

進一步減小交叉污染。使用 Seat Backflush時，流路如下圖： 

洗針方式： 
選擇標準清洗 

只 建 議 有 經
驗，且的確需
要的客戶使用
使用  

進樣器的吸樣
和推樣速度，
一般不要調整 

選擇是否啟用瓶
底自動檢測功能 

進樣體積  

停止時間：一般
設置為和泵一樣 

進樣針插入深
度調整 

 

設置埠沖洗，以及沖

洗時間 

設置樣品瓶沖洗，以

及樣品瓶位置 
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7.2.1.2 G7129A/B Vialsampler自動進樣器的方法設置 

注意：如果您使用的是其他型號的自動進樣器，請忽略此部分內容。 

在方法編輯介面可以設置進樣方式，進樣體積等。為了減少交叉污染和降低進樣殘留，進樣方

式一般選擇洗針進樣。洗針方式可以使用某個固定位置的樣品瓶（Wash Vial），也可以使用清洗埠

洗針（Flush Port）。相對來說使用清洗埠可以取得更好的洗針效果。一般都選擇這種模式，清洗時

間 3-10秒鐘就足夠了。 

如果在樣品資訊或者工作清單中設置了進樣體積，那麼這裡設置的進樣量會被忽略，而採用樣

品資訊或者工作清單中的設置。 

 
取樣位置可以調整進樣針的插入位置，默認為零。使用標準樣品瓶時針尖距離瓶底的距離約為

2mm。當樣品量比較多並且擔心有沉澱的時候，可以選擇把針的位置抬高。 

當樣品量很少時，也可以考慮把針的位置降低（最多比默認位置降低 2.5 mm）。 

注意：如果設置降低針的位置的時候，請特別小心操作，每個自動進樣器可以降低的數值是不一樣

的。防止進樣針降的過低紮壞樣品瓶，損壞進樣針和自動進樣器。 

7.2.2泵的參數設置 

7.2.2.1 二元泵的參數設置 

在泵的參數設置介面可以設置泵的流量、流動相比例、資料停止採集時間等。下圖是一個帶有

溶劑選擇閥的二元泵設置介面，它有兩個 A通道和兩個 B通道。帶有溶劑選擇閥的二元泵給用戶提供

了更多的功能選擇，可以選擇使用 A1-B1、A1-B2、A2-B1 以及 A2-B2 四種溶劑組合方式，但是，不能

同時使用 A1-A2或者 B1-B2。 

高通量：一

般不要使用 

進樣體積 

進樣針取樣
位置調整 

兩種洗針方式：  
埠清洗； 
樣品瓶清洗； 
一般使用埠清洗 

停止時間已按設
置和泵一樣 
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儀器在後執行時間內並不採集資料。此時，流動相比例和流速會回到方法起始的流動相比例和

流速，然後會繼續沖洗這裡設定的後執行時間後，才會繼續進下一針樣品。因而適合用在含有梯度

洗脫的方法中平衡層析柱。 

對於高壓二元泵，請在下拉清單中選擇相應溶劑瓶中的溶劑種類。溶劑類型決定該通道的壓縮

因數；壓縮因數是指當給溶劑施加壓力時，該溶劑可以被壓縮的程度。壓縮因數越大，說明該溶劑

越容易被壓縮。壓縮因數的正確設置對於二元泵能否精密準確的工作非常重要。 

        
在 Advanced 選項下可以泵的最小衝程，溶劑的壓縮因數等。如沒有特殊情況，衝程一般都設成

使用 Automatic。 對於 Mixer的選擇會影響 ISET的可靠性。 

ISET: ISET (Intelligent System Emulation Technology)，使用者可以使用現有的1290系統，類比其他液

相的延遲體積及混合行為，可以得到和其他液相相似的層析結果。 

 

7.2.2.2 四元泵的參數設置 

 

四元泵可以最多同時運行 4種不同的流動相。在泵的參數設置介面可以設置泵的流量、流動相比

例、資料停止採集時間等。 

泵的流速 

運行停止時間 

後執行時間，用於梯度洗脫方法 

從下拉清單選

擇溶劑種類 

系統最小和最大壓力 

用戶可對流動相加任意注釋 

 

梯度洗脫表，設定梯度洗脫程
式，可以編寫流量和壓力的時間
程式。可以通過插入、附加、剪
切、複製和粘帖等功能方便的進
行編輯。 

泵的衝程設置，

一般設置自動衝

程 ，

Synchronized 功

能一定勾選 

是否使用溶劑類型

表，默認使用。 

流速變化最大速

率，使用預設值 當前使用過的混

合器體積 
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在 Advanced介面可以設置最小衝程，溶劑的壓縮因數等參數。 

 
 

7.2.3柱溫箱參數設置 

這裡可以設置柱溫箱的控制溫度，可以選定某一溫度或者不控制。大部分應用情況下，左右加

熱的溫度設置成相同值（即右加熱塊選擇 Combined）。如果系統中有 DAD 檢測器，還可以問題和

DAD一致。 

 
 

 

7.2.4 紫外檢測器的參數設置 

7.2.4.1 DAD檢測器的參數設置 

注意：如果您的儀器沒有配置 DAD檢測器，請忽略此部分內容。G4212A/B型號 DAD檢測器沒有可見

設置不關柱溫箱門是否允許運行 

設置允許的柱溫偏差
範圍 

設定流動相 B(或 C/D)的百分
比和流速如何隨時間變化 

運行停
止時間 

流速 

可以對流動
相加以注釋 

後執行時間 

最小衝程，一般設為自動 

壓縮因數。四元泵一般
使用此設置即可 

一般設置為自動 

最大允許壓力 
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光燈。G4212B型號 DAD檢測器不能設置狹縫寬度。 

在 Signals選項裡面設置檢測波長和頻寬，以及參比波長和相應的頻寬。 

樣品波長應該設為樣品最大紫外吸收波長；樣品頻寬應該設為樣品紫外吸收光譜的半峰寬，至

少應該等於或大於狹縫寬度。參比波長的作用是減少基線飄移和週期性波動，應該選擇在盡可能靠

近樣品信號，同時紫外吸收很低或沒有的地方。參比頻寬應該等於或大於樣品頻寬。可以設置同時

保存多個通道的資料，也可以選擇是否使用參比。 

Spectrum選項則設置是否保存 DAD的三維資料，以及保存的波長範圍。 

Lamps on required for acquisition Required lamps選項，設置分析時是否需要紫外燈(UV)和可見光燈

(Vis)。在不需要 DAD 進行檢測的時候，可以都不選中。這樣即使不開燈也可以進行分析。另外還可

以設置自動調零(Autobalance)，狹縫寬度等參數。 

半峰寬（Peak Width）的選擇，決定了採樣頻率的高低。半峰寬設置過大，有可能引起丟峰或重

現性差；如果設置過小，則會增加基線噪音。半峰寬與採樣頻率的關係參考下面表格。一般來說，

要得到一個完美的層析峰，需要 15-20個資料點。 

 

 
 

 

 

 

半峰寬與採樣頻率的關係如下表： 

Peak Width 採樣速度(Hz) 

0.0012 160 

0.0025 80 

0.005 40 Hz 

0.01 20 Hz 

0.03 10 Hz 

0.05 5 Hz 

0.1 2.5 Hz 

0.2 1.25 Hz 

0.4 0.625 Hz 

0.85 0.3125 Hz 

檢測波長和頻寬 參比波長和頻寬 

停止時間一般設
置成和泵相同 

是否保存光
譜以及保存
的波長範圍 

半峰寬，即採樣頻率設置 

選擇是否需要氘燈和鎢
燈。如果都不選擇，那
麼可以不開燈運行方法 

是否需要自動調
零，一般選 Prerun 

要保存的信號通道。只有
勾選的通道信號才被保存 
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7.2.4.2 VWD檢測器的參數設置 

注意：如果您的儀器沒有配置 VWD檢測器，請忽略此部分內容。 

需要設置檢測波長、半峰寬等參數。檢測波長應該為待分析物質的最大紫外吸收波長。半峰寬

的設置決定了儀器的採樣頻率，可以參考上面 DAD的半峰寬設置的介紹。 

VWD一般選擇在運行前(Prerun)自動調零。如果不選擇 Lamp on required for acquisition，則可以在

VWD的氘燈不打開的情況下運行方法。 

 

 

 

7.3 三重四極柱採集參數的設定  

7.3.1 調機檔選擇、時間過濾和時間分段等設定 

在MS 三重四極柱參數畫面， 我們首先介紹左側的設置。 

 

缺省的調機文件為atunes.Tune.xml，如果沒有必要，不要改動。但是我們也可以點擊Browse按鈕

調用任何一次調機的調機文件。如果點擊 按鈕則會顯示當前調用調機檔的所有參數。 

 

 

 

 

 

 

 

 
 

檢測波長 

執行時間，
設成和泵一
樣 

類比輸出，連積分儀或
協力廠商軟體可能用到 

不選擇此項則允許在關閉
氘燈的情況下進行分析 

半 峰 寬 ，
即 採 集 頻
率 如出負峰可通

過此選項改變 

自動調零，一
般在運行前 
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離子源選擇必須與實際安裝的類型一致，否則儀器會顯示Ion Source not identical, 無法工作。 

時間過濾（Time Filtering）實際是一種層析圖的平滑處理選項。如果不選擇此核取方塊，則對層

析圖不會進行任何的平滑。如果使用此選項，那麼峰寬（Peak Width）的設置最大值為樣品的最窄層

析峰的半峰寬，超出就會出現資料獲取丟峰的情況。使用此核取方塊的時候，軟體自動每11個資料

點進行一次高斯平滑。 

時間段（Time Segments），如果同時分析多種化合物，可以根據保留時間不同劃分成若干個時

間段。與不分段相比，每個時間段內採集的離子個數減少，則採樣週期縮短，有助於提高儀器靈敏

度。每個時間段可以採用不同的極性模式。每個時間段LC流出的流動相也可以選擇不同的處理方

式，既可以切換到質譜，也可以直接切換到廢液（Div Valve選項）每個時間段可以選擇保存資料，也

可以選擇不保存資料（Store選項）。 

右鍵在時間段區域點擊可以彈出功能表選擇增加或刪除時間段。 

Delta EMV(+)、DeltaEMV(-)分別為正、負離子模式下，在調機的EMV的基礎上增加的電壓數值。

在一定範圍內，增加Delta EMV可以提高靈敏度和信噪比。每個時間段可以設置不同的值。 

注意：在滿足檢測靈敏度要求的前提下，Delta EMV的數值越小越好，越小越有利於延長電子倍增器

的壽命。一般使用200-400V。Delta EMV設置的越高，電子倍增器的使用壽命越短。 

7.3.2 掃描（MS2 Scan）採集模式的參數設置 

MS1 工作在離子全通過（TTI）狀態下，所有的帶電離子全都通過；碰撞池不施加碰撞能量，不

會把離子撞碎；而 MS2工作在掃描模式，可以得到待分析物質的一級質譜圖。 

這種工作方式在三重四極柱中一般用於確認物質的分子離子峰。 

停止時間設置為

和泵一樣 

缺省的調諧文件為

atunes.Tune.xml ， 即

當前自動調諧的結果。 

選擇使用的離子源類

型。必須和實際安裝

的類型一致，否則無

法工作。 

色譜圖平滑選項。

Peak Width應該設置

為 最 窄 峰 的 半 峰

寬。 

時間段設置。可以根

據需要把執行時間分

成幾段，每段時間內

的事件可以不同 

LC 流動相進入質譜還

是廢液的選擇 

分別表示正、負模式下 EMV 電壓

相對自動調諧電壓的增加值 

某個時間段的資料

是否保存的選擇 
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設置時，在掃描類型（Scan Type）下拉清單選擇MS2 Scan，右鍵點擊時間段區域可以增加或刪

除時間段。在右側的掃描段區域右鍵點擊，在彈出的功能表總可以選擇增加或刪除掃描段。每個時

間段內最多可以設置4個掃描段。 

每個掃描段可以設置不同的名稱，並需要設置掃描的質量範圍、掃描時間、Fragmentor電壓

（6495預設為380V不可更改），極性等。 

 

 

 

7.3.3 選擇離子監測（MS2 SIM）採集模式的參數設置 

MS1 工作在離子全通過（TTI）狀態下，所有的帶電離子全都通過；碰撞池不施加碰撞能量，不

會把離子撞碎；而 MS2工作在 SIM模式，可以得到選定的離子的一級質譜圖。 

這種工作模式一般用於優化待分析物質的 Fragmentor電壓（6495預設為 380V不可更改）。 

 

在掃描類型下拉清單選擇MS2 SIM，並可以像MS2 Scan一樣增加或刪除時間段以及掃描段。在每

個掃描段中，每一行對應一種化合物，可以輸入該化合物的名稱，以及是否作為內標。這些資訊可

以自動導入定量軟體中。 

這裡需要設置選擇監測的離子的質荷比，以及質譜解析度為Unit、Wide或Widest，並需要設置駐

留時間，Fragmentor電壓，加速電壓的大小和極性的選擇。 

本掃描段的掃描時間 

Fragmentor 電壓。通常

分子量越大，需要設定

的值越高。默認 135V 

極性，每個掃描段可

以設置不同的極性 

掃描段名稱 

通過下拉式功

能表選擇 MS2 

Scan 

化合物名稱 
解析度 

駐留時間 

掃描範圍  

資料存儲為輪

廓圖還是棒狀

圖以及掃描步

長 

加速電壓，通常分子

量越大，設定值越

大，不可為 0 



 

版權所有  影印必究 

 

 

7.3.4 子離子掃描（Product Ion Scan）採集模式的參數設置 

MS1 使用SIM 方式選擇某一個或多個特定質荷比的母離子通過四極柱1，在碰撞池施加碰撞能量

產生碎片離子，然後在MS2 中進行掃描分析。此過程可以產生典型的質譜/質譜碎片譜圖。 

三重四極柱通過這種工作方式可以得到待分析物質的二級質譜圖，從而幫助確定在做多重反應監測

時使用的定量離子和定性離子。 

 

在掃描類型下拉清單選擇Product Ion，並需要設定母離子的質荷比、子離子的掃描範圍和碰撞能

量以及掃描時間、Fragmentor電壓（6495預設為380V不可更改）、碰撞能量和極性等參數。 

 

7.3.5 多重反應監測（MRM）採集模式的參數設置 

MS1 採用SIM 方式選擇某個或多質荷比的母離子，在碰撞池施加碰撞能量產生碎片離子。MS2 

同樣採用SIM方式來監測由母離子產生的一個或幾個特定子離子。這就是多重反應監測（MRM）。這

種方式可以極大提高檢測靈敏度和定量準確性。是三重四極柱儀器最主要的使用方式。 

 

在下拉清單中選擇 MRM。當分析化合物的種類較多和複雜時，可以根據化合物的保留時間劃分

成若干個時間段。這樣每個時間段內採集的離子個數減少，則採樣週期縮短，有助於提高儀器靈敏

度。 

每個化合物需要設定其母離子以及定量子離子，還可以進一步設定一個或幾個定性子離子，來

進一步增強檢測的特異性，減少假陽性。 

下拉選擇 Product Ion 

碰撞能量設定 

子離子的掃描範圍 

母離子設定 

是否選作內標 

離子的質荷比 

Fragmentor電壓 

極性選擇 

下拉選擇 MS2 SIM 

極性設定 
掃描時間 

Fragmentor電壓 

加速電壓 

加速電壓 



 

版權所有  影印必究 

 

對於同一個化合物，其不同子離子的最優碰撞能量可能不同，需要在方法開發時進行優化。 

每個掃描段的不同離子可以設置不同的極性。不同極性的離子，推薦設置在不同的時間段內進

行檢測。一般情況下不建議同一個時間段內採集不同的極性，否則設置不當有可能增加噪音，降低

檢測的靈敏度、準確性和重現性。 

 

7.3.6 帶有安捷倫噴射流技術的 ESI源的參數設置 

與普通ESI源相比，帶有安捷倫噴射流技術的ESI源增加了Sheath Gas Temp 、Sheath Gas Flow和

Nozzle Voltage參數。 

 

 

 

Jet Stream推薦的起始條件如下： 

參數 
推薦值 

6470 6495 

HPLC流速 250-600 μL/min 250-600 μL/min 

鞘氣溫度 250℃ 250℃ 

鞘氣流速 11 L/min 11 L/min 

噴嘴電壓 500 V 500 V 

霧化器壓力 35psi 35 psi 

毛細管電壓 
4000 V (pos) 

3500 V (Neg) 

4000 V (pos) 

3500 V (Neg) 

乾燥氣流速 5 L/min 14 L/min 

乾燥氣溫度 300 ℃ 200 ℃ 

高壓 Funnel RF 無 150V 

下拉式功能表選擇

MRM 

化合物名稱 母離子 

母離子解析度 

加速電壓 

子離子解析度 

碰撞能量 

極性 

子離子 

Fragmentor電壓 駐留時間 

是否設定為內標 

Jet Steam 操作時且忌直接打開離子源。設置為 Standby 後，也務必等待鞘氣溫度下降至

125度後，才能開打開離子源。否則很容易燒壞鞘氣的加熱元件 

 

乾燥氣溫度 

乾燥氣流量 

霧化氣壓力 

鞘氣溫度 

鞘氣流量 

毛細管電壓 

噴嘴電壓 
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低壓 Funnel RF 無 60V 

一般 HPLC的流速在 250-600 μL/min之間時，儀器可以達到最佳的靈敏度。 

對靈敏度影響由大到小依次是：鞘氣的溫度和流速，噴嘴電壓，霧化氣壓力，毛細管電壓，乾

燥氣溫度和流速。 

7.3.7 APCI源的參數設置 

APCI源與 ESI不同，APCI需要足夠的液體流量以得到最佳的離子信號。一般來說，500 μL/min的

流速會得到比 200 μL/min的流速更高的靈敏度。需要通過實驗來確認所分析物質的最佳 HPLC流速。 

對於 APCI來說，甲醇是比乙腈更好的溶劑。 

蒸發器溫度需要根據使用的溶劑，HPLC 的流速以及所分析的具體物質做進一步的優化。最佳的

蒸發器溫度與所分析的物質相關，難揮發的物質需要更高的溫度。 

 

 

APCI源的參考條件設置如下： 

HPLC流速 

μL/min  

霧化氣壓力 

Nebulizer pressure 

乾燥氣流量 

Drying Gas Flow 

乾燥氣溫度 

Drying Gas Temp 

蒸發器溫度 

Vaporizer Temp 

電暈電流 

Corona Current 

毛細管電壓 

Capillary Voltage 

200-1500  60 psi 4-6 L/min 350 ℃ 300-500 ℃ 
4 uA(正) 

10uA(負) 
3500 V 

7.3.8 層析圖介面設置 

在層析圖介面可以設置在普通顯示區顯示的質譜信號的資訊，比如 TIC，EIC或 MRM等。 

 

點擊右鍵可以增加新的需要顯示的信號。 

7.3.9 Instrument介面設置 

在Instrument介面可以設置需要保存在資料檔案中的質譜參數。默認不保存。選擇某個參數，然

後點擊向右的箭頭就可把該參數加入的保存的列表內。 

乾燥氣溫度 

蒸發器溫度 

乾燥氣流量 

霧化氣壓力 

電暈電流 

毛細管電壓 
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7.3.10 診斷介面 

在診斷介面下可以查看儀器的型號和固件版本（Firmware），兩個四極柱的溫度，前級真空和高

真空的讀數，以及渦輪泵的轉速和功率等資訊。 

 

 

7.4 方法屬性  

可以設置方法前運行和後運行的動作，以及給方法添加一些說明和描述。 

 

 

 

選擇某個參數，然後點擊向右的箭頭

就可把該參數加入的保存的列表內 

設置方法前運行

和後運行的動作 

給方法添加一些

說明和描述 
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7.5 資料處理  

可以添加資料處理的方法，樣品運行完成後，直接出具定性或定量報告。 

 

 

 

7.6 保存方法  

在 Method Editor頁面下點擊 可以保存當前方法，點擊 可以把方法另存為其他名字。 
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8. 單針樣品和工作列表的運行 

8.1 運行單針樣品 

點擊進入 Single Run頁面，輸入樣品名稱、瓶號、資料檔案名以及資料保存路徑等。 

資料檔案的命名默認自動遞增，如果不選擇此核取方塊，則每個檔需手動命名，否則重複的資

料檔案會覆蓋。 

 

注意：建議把所有的方法和資料都放在特定的目錄下，便於將來查找和備份。 

點擊 Single Run 頁面的 或者工具列的 快捷按鈕，開始運行樣品。工具列與樣品運行相

關快捷按鈕的意義如下： 

表示資料檔案處於開放狀態，任何同一目錄下重名的檔都不能被覆蓋，只能命名成

不同名字。 

 表示資料檔案處於鎖定狀態，若出現同名檔的時候軟體會詢問是否要覆蓋。 

運行單針樣品的快捷按鈕。 運行 Worklist的快捷按鈕。 

在即時層析圖顯示區按一下滑鼠右鍵，按一下 Change，在彈出的對話方塊中左側選擇想要監視

的信號按一下 Add添加，設定範圍後，按一下 OK。 

 

 

                                                                                                               

注意：建議把所有的方法和資料都放在特定的目錄下，便於將來查找和備份。 

樣品位置 樣品名稱 

進樣體積：輸入數

值或選擇 As Method 

選擇資料檔案名編

號是否自動遞增 
資料保存路徑。點此按鈕

可以更改資料存儲路徑 

資料檔案名稱 

點此按鈕可以

直接運行樣品 
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8.2編輯和運行 Worklist 

工作列表(Worklist)是自動進行樣品分析的一系列指令。使用工作列表，可對多個樣品實現自動

進樣分析。 

8.2.1 創建工作列表 

點擊進入 Worklist頁面，會顯示當前打開的 Worklist。 

 

工作列表面板點擊右鍵，通過彈出的功能表可以實現添加單個或多個樣品，複製，插入等功能。

這和通過 Worklist功能表能實現的功能相同。 

在 Worklist出點擊右鍵，從彈出的功能表選擇 Show/Hide/Order Columns，我們就可以在彈出的視窗增

加或者減少在 Worklist表格裡面顯示的內容，比如，我們可以增加 Inj Vol(uL)進樣體積項。 

 

  

 

 

 

8.2.2 往工作列表添加一個樣品 

從 Worklist功能表中選擇 Add Sample ，工作清單表格就添加了一行新的樣品。我們可以接在工作

清單表格輸入以下樣品資訊：樣品名稱，樣品位置，方法，資料檔案名稱，樣品類型，進樣體積，

備註和級別名稱等。 

 

 

 

 

 

 

 

樣品名稱 

樣品位置  

採集方法  

資料檔案  

樣品類型  

校正樣品或

QC樣品級別 

進樣體積 

樣品類型  
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8.2.3 往工作列表添加多個樣品 

在工作面板點右鍵或從 Worklist功能表選擇 Add Multiple Samples。在 Sample Information選項卡下，

填寫樣品名稱，資料檔案名稱，調用方法，方法路徑以及資料檔案儲存路徑等。點擊 sample Position

選項卡，選擇要添加的樣品所放置的位置。 

 

點擊並拖動滑鼠來確定一個鄰近的區域；在鍵盤上按住 Ctrl 點擊並拖動滑鼠，可以選擇其不相鄰

的位置的樣品；使用鍵盤的 Ctrl+Shift 鍵可以在不同位置選擇多個樣品。 

點擊 OK 關閉 Add Multiple Samples 對話方塊。設定的樣品出現在 Worklist表格，並且可以進行再

次編輯。 

 

8.2.4 設置工作列表完成後自動待機 

從 Worklist功能表選擇 Worklist Run Parameters…，設定工作清單的運行資訊，方法路徑以及資料

檔案儲存路徑等。勾選 Post worklist ，點擊 快捷按鈕，在彈出的視窗選擇 SCP_InstrumentStandby，

這個 Script的功能是使得 Worklist 在運行完畢後儀器自動切換到 Standby。 
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這個功能也可以在 Worklist 的最後一行點擊右鍵，選擇 Add Script…，在彈出的視窗選擇

SCP_InstrumentStandby。 

8.2.5 保存和運行工作列表  

在 Worklist頁面下點擊 可以保存當前 Worklist，點擊 可以把 Worklist另存為其他名字。 

在 Worlist頁面下點擊 按鈕，或者點擊工具列上的 快捷按鈕，開始運行工作清單。 

               全部進樣 

 

     打勾表示需要運行的樣品 

 

在工作列表運行過程中，可以繼續編輯和增加樣品，也可以刪除樣品，或者通過樣品前的核取

方塊決定是否取消某個樣品的運行。 

在工作列表運行過程中，可以點擊 Worklist頁面或工具列上的 按鈕停止工作清單的運行。 

也可以點擊 Worklist頁面或工具列上的 按鈕，暫停工作清單的運行。再次點擊此按鈕則可以恢

復 Worklist的運行。 
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9. 定性分析 

定性分析詳細的入門手冊可以從定性軟體光碟的 Manual 目錄找到。安裝程式會自動根據電腦作

業系統的語言設置安裝相應語言的軟體。 

         

按兩下 Agilent Masshunter Qualitative Analysis 圖示 ，打開定性分析軟體。 

請從定性分析軟體光碟總把 Data目錄下的所有檔複製到硬碟上作為熟悉軟體用資料。 

 

9.1 定性軟體的主要功能區和常用快速鍵  

定性軟體的主要功能區常用快速鍵和介紹如下。 

 

 

    

  

方法流覽區 

資料流覽區 

打開資料檔案 關閉資料檔案 保存處理結果 

色譜圖顯示區 

質譜圖顯示區 

顯示質譜預覽 顯示質譜圖結果 顯示積分結果 

分別顯示 重疊顯示 同時顯示的個數 

範圍選擇 手動積分 
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在定性分析軟體內，各個視窗可以任意拖動排列。如果需要預設視窗設置介面，可以通過

Configuration功能表列上按一下 Windows Layout > Restore Default Layout來操作。（B.03.01之前的軟體

通過 View >Windows Layout > Restore Default Layout功能表來操作） 

 

打開定性分析軟體時會自動彈出 Open Data File 對話方塊，選中待分析的資料檔案，按一下 Open

按鈕，即可打開。此對話方塊也可以通過直接點擊功能表列上打開資料檔案的快捷按鈕實現。 

在定性分析軟體內，打開一個新資料時，原來打開的資料並不會關閉，而是會順序排列在資料

流覽區內。如果需要關閉某些資料的話，可以點擊關閉資料的快捷按鈕，選擇要關閉的資料即可。 

 

9.2 放大或縮小譜圖  

要放大或縮小 X軸，請將游標移到 X軸下方直到出現水準雙箭頭 。按住滑鼠右鍵並從左向右

拖動，則 X軸放大；按住滑鼠右鍵並從右向左拖動，則 X軸縮小。 

按一下 圖示完全縮小 X軸。 

要放大 Y 軸，請將游標移到 Y 軸左側直到出現垂直雙箭頭 。按住滑鼠右鍵並從下向上拖動，則

Y軸放大；按住滑鼠右鍵並從上向下拖動，則 Y軸縮小。 

按一下 圖示完全縮小 Y軸。 

按一下 圖示同時完全縮小 X軸和 Y軸。 

這個功能在定性、定量軟體的所有視窗都適用。不僅適用於層析圖，也適用於質譜圖。按住滑

鼠右鍵拖動可以放大或縮小；按住滑鼠左鍵拖動則是座標平移。 

注意：另外一個放大的方法是在層析圖或質譜圖內按住並拖動右鍵選擇一個區域，則該區域被放大。 

 

9.3 提取層析圖  

右鍵點擊資料導航區選擇的資料，或者在層析圖顯示區域點擊右鍵，在彈出的功能表選擇Extract 

Chromatograms。 

如果不想顯示某個譜圖的

話，可以直接把其前面的勾

取消，則不會在譜圖區顯示 

如果要關閉某些或某個資料

的話，可以點擊關閉快捷按

鈕，在彈出的視窗選擇要關

閉的資料即可。 

也可以直接右鍵點擊要關閉

的資料，在彈出的功能表選

擇 Close Data File 
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比如要提取 EIC，則在下圖中的 Type 下拉選擇 EIC，在 m/z Values(s)處輸入要提取的質量數，點

擊 OK按鈕 即可。如果要同時提取多個不同質量的層析圖，則可以輸入多個數值，以逗號分開。還可

以提取一段質量範圍的層析，比如可以輸入 278-281 這樣一段質量範圍。在同時提取多個層析圖時，

如果選中 Merge Multiple masses into one chromatogram，則提出的所有層析圖會自動合併顯示在同一個

視窗內。如果不選擇該項的話，則會分別顯示在獨立的視窗內。 

 

 

9.4 提取質譜圖  

在層析圖視窗，首先確認高亮 按鈕。如果要提取某點的質譜圖，直接在該點按兩下左鍵即

可。如果要得到某時間段的平均質譜圖，可以在 TIC 圖上按住滑鼠左鍵並拖拉滑鼠，選擇一段範圍，

然後在選中的區域按兩下滑鼠左鍵即可。或者在選中的區域點擊滑鼠右鍵，從彈出的功能表選擇

Extract Spectrum，也可以得到選擇的這段時間的平均質譜圖。 

通過下拉式功能表

選擇要提取的譜圖

類型 

如果同時提取多個離子的話，

不同的離子之間用逗號隔開；

同時，如果提取多個離子的

話，可以選擇是否合併在同一

張譜圖中顯示 

要提取的質譜圖類型，是

一級、二級還是所有的 

要提取的離子極

性是正還是負 
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對於不想要的層析圖或質譜圖，可以用滑鼠點擊選中它，按鍵盤上的 Delete 鍵即可刪除；或者

直接在相應視窗內右鍵點擊，在彈出的功能表選擇 Delete即可。 

這時，軟體會彈出一個視窗提示 Delete all highlighted items?，如果點擊 Yes 按鈕，所有被選中的

譜圖都會被刪除。如果選擇了 Do not show this message box again，那麼以後在刪除譜圖的時候，不再

提示即直接刪除。 

 

9.5 提取和扣除質譜背景  

在 TIC 圖中使用選擇範圍工具 選擇某點或一段背景範圍，按一下滑鼠右鍵，選擇 Extract 

Spectrum to Background，該質譜圖被自動加入到背景質譜圖(Background Spectra)。 

 

在 MS Spectrum Results 內的某張質譜圖上右鍵點擊，在彈出的視窗選擇 Substract Background 

Spectrum。則該質譜圖會自動扣除掉上面的背景質譜圖，  
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若要把已有的某張質譜圖作為背景來扣除的話，可以直接選中該質譜圖，然後點擊右鍵，在彈

出的功能表選擇 Move to Background Spectrum。那麼該質譜圖就會被放入 Background Spectra，可以被

其他的質譜圖作為背景來扣除了。 

 

 

顯示已扣除背景的質譜圖 
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9.6 改變質譜圖離子顯示的閾值  

有時需要改變離子質量顯示的閾值來調整顯示的範圍。在質譜圖區域點擊右鍵，從彈出的功能

表選擇 Adjust Peak Threshold。可以上下拖動 Threshold 的虛線進行調整。調整後，顯示的離子數隨之

變化。在 Threshold以下的離子都不會標示質荷比。 

 

 

9.7 輪廓圖轉化為棒狀圖  

如果採集的資料是輪廓圖，可以通過分析軟體把相應的質譜圖轉化為棒狀圖；但是反過來，如

果採集的資料是棒狀圖。則無法通過分析軟體轉化為輪廓圖。 

右鍵點擊質譜圖，在彈出的功能表選擇 Convert Profile to Centroid，可以把質譜圖轉化為棒狀圖。 

 
 

9.8 提取紫外層析圖和光譜圖  

在定性軟體中，即使我們採集了紫外檢測器（DAD 或 VWD）的信號，在打開資料時預設也不會

自動打開紫外的信號。如果我們需要查看採集的紫外層析圖，請首先打開該資料的 TIC 譜圖，在譜圖

上按一下右鍵，選擇提取層析圖，然後從 Type 處下拉選擇 Other Chromatogram 即可。  

 

如果儀器配置有 DAD 檢測器，並且在採集資料時存儲了 DAD 的光譜資料，那麼我們還可以查看

相應的紫外光譜圖。在提取出的紫外層析圖區域按兩下左鍵，就可以顯示該點的紫外掃描圖。。 
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9.9 Walk  Chromatogram 和 Spectrum Preview  

點擊 的圖示，則進入了 Walk Chromatogram 狀態。可以把滑鼠移到層析圖區域，通過鍵盤的

左右方向鍵快速的查看整個層析圖時間範圍內任一時間點的質譜圖。 

 

MS Spectrum Results 視窗內顯示的質譜圖都會添加到使用者質譜圖中，可以隨資料保存。而 MS 

Spectrum Preview視窗內顯示的質譜圖只是流覽而已，不會自動加入用戶質譜圖中去，也不能保存。 

在 MS Spectral Preview顯示的質譜圖視窗上點擊滑鼠右鍵選擇 Copy to User Spectra，則會將這張質

譜圖添加到左側資料導航區中的使用者質譜圖中，視窗的標題也改變為 MS Spectrum Results。 

 

點擊 Spectrum Preview按鈕，退出 Spectrum Preview模式。或者直接關閉 Spectrum Preview視窗。

注意，在 Spectrum Preview模式下，無法直接按兩下獲取 MS Spectrum Results。 

 

Spectrum Preview按鈕 
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9.10 計算信噪比  

左邊的方法流覽區，在 chromatogram 內選擇 Calculate Signal-to-Noise，然後在右側選擇噪音的計

算方法以及噪音的時間範圍，點擊執行按鈕即可計算信噪比。噪音有四種計算方法。請根據自己的

要求選擇合適的噪音計算方法。 

 

9.11 積分  

要對層析圖進行積分，在方法流覽區選擇 Chromatogram 功能區，根據不同需要進行積分選擇，

如積分 UV 譜圖，選擇 Integrate (UV)，要積分一級質譜，選擇 Integrate(MS)等。在彈出的視窗選擇合

適的積分器，建議優先選擇 Agile 積分器。這個積分器不需要設置積分參數，使用簡單。然後點擊綠

色箭頭 進行積分；也可以直接右鍵點擊層析圖，在彈出的功能表選擇 Integrate Chromatogram進行

積分。 

積分結果列表可以點擊 來查看。 

 

  

點擊此按鈕開

始執行計算 

可以讓軟體自動

選擇噪音範圍 

積分結果列表 

也手動指定噪

音時間範圍 

噪音的類型選擇 

積分器選擇 

積分類型 
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9.12 列印分析報告  

從 File功能表選擇 Print>Analysis Report… 

 

然後會彈出下面的視窗。從左側選擇要列印的資料檔案，可以選擇一個或多個打開的資料。設

定好報告選項後，點擊 OK按鈕生成報告。 

 

 

 

 

  

 

All results: 列印所有左側打開的資料的分析報告 

Only highlighted result:只列印左側選中資料的分析報告 

Separate Report per data file: 在列印多個資料的分析報告的時

候，選擇此項，則每個資料生成一個獨立的報告；否則，所

有資料的分析報告列印在一起。 

 

從下拉清單選擇印表機，

缺省選擇的是預設印表機 

選擇此項，則只是預覽列

印，不真正列印報告 

選擇此項，則報告會保

存成 Excel檔 

選擇此項，則報告會

保存成 pdf檔 

選擇報告是保存在資料檔案

目錄下，或指定的其他目錄

下 

如果已經存在該資料的報告，選擇生成報告時

覆蓋原來的報告文件，還是自動生成新的報告 
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10. 定量分析——創建定量的批次處理和定量方法 

本部分基於已經採集到的 MRM資料來創建批次處理和定量方法，參考下面步驟進行練習。 

按兩下桌面上的三重四極柱定量分析軟體圖示 ，運行定量軟體。按一下工具列上“Restore 

Default Layout” 按鈕確認主畫面恢復為缺省佈局。 

 

 

10.1 內標法定量（ ISTD）  

內標法定量介紹使用定量分析軟體光碟內 Data\DrugofAbuse目錄下的檔進行講解。建議在電腦的

D盤建立一個 Demo Data的資料夾，把所有定量分析軟體的 Data目錄下的檔都複製到這一目錄，以便

進行軟體的熟悉和練習。 

按一下功能表項目 File > New Batch: 

 

在新的批次處理對話方塊，找到資料檔案夾，例如 “D:\Masshunter\Demo Data\DrugOfAbuse”，輸

入批次檔名 例如“qqq” 並點擊 Open 按鈕創建一個新的批次檔： 

 

軟體自動彈出 Add Sample 對話方塊，按一下選擇 Select All按鈕然後按一下 OK來添加所有樣品： 
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按一下菜單 Method > New > New Method from Acquired MRM Data 

 

用滑鼠選擇 CMAMCal_L5.d並點擊 Open按鈕導入 MRM方法採集資訊(此處需要選擇最有代表性的

譜圖，一般選擇較高濃度樣品資料，這樣保留時間，離子比例等比較準確)： 

 

 

在左側 Method SetupTasks 選項下自上而下進行，首先點擊 MRM Compound Setup 檢查導入的用於

MRM 化合物設置的採集參數是否正確。 
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按一下方法設置任務 Method Setup Tasks> Retention Time Setup，檢查確認導入的參數。 

 

 

按一下方法設置任務 Method Setup Tasks>ISTD Setup，然後從下拉式功能表 ISTD CompoundName

為每個目標化合物指定內標化合物(ISTD），ISTD Conc 列輸入相應內標化合物的加入濃度。 

本例中每種化合物均以其氘代產物作為內標。 
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按一下方法設置任務 Method Setup Tasks >Concentration Setup， 

 

按一下 Method方法功能表選擇“Create Levers from Calibration Samples” 

 

填寫各級別校正樣品的濃度， 

           

         按一下 Method方法功能表選擇 Copy Calibration Levels To… 在複製校正級別對話方塊，按一下選

擇所有（Select All）對話方塊，然後按一下 OK 按鈕。 
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流覽方法表（Method Table）比較四個目標化合物“Amp”, “Cocaine”, “Meth” 和 “MSDA” 的校正濃

度設置。 
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按一下方法設置任務 Method Setup Tasks >Qualifier Setup，檢查定性離子設置（Qualifier setup）參

數，在導入 MRM方法採集參數時定性離子參數自動產生。 

 

按一下方法設置任務-校正曲線設置 Method Setup Tasks > Calibration Curve Setup, 檢查每個目標化

合物曲線擬合（Curve Fit ）的缺省設置： 
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按一下 Save/Exit >Validate 驗證方法設置，如果有錯誤提示，請按照提示進行改正並重新 Validate。

直到軟體提示：Method validated. No errors or warnings found. 

 

 

按一下 Exit，然後選擇 Analyze，最後點 Yes 應用方法到此批次處理表 

 
軟體會自動分析批資料。檢查批次處理分析結果，化合物資訊和校正曲線顯示在分析結果的下

部。這個表格可以通過功能表 File > Export匯出成 Excel檔。 
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點擊 File >Save Batch，保存批次處理。如果需要關閉，點擊 File >Close 關閉批次處理。 

要產生定量報告，按一下 Report >Generate 

 

在 Generate Report 介面，選擇New，建立新報告方法（如果已有報告方法，直接選擇 Choose）， 

 

選擇 Add Template， 
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選擇報告範本 

 

 

。 

選擇生成報告的格式，點 Save&Exit， 

 

選擇保存路徑，點 Save，保存報告方法。 
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選擇生成報告的路徑，點 OK，生成報告。 

 

 

在指定目錄下，找到 QuantReports資料夾按照 Batch名稱找到新產生的 Excel報告。可以按兩下打

開查看。 

 

10.2 外表法定量（ESTD）  

外標法定量的步驟與內標法定量相似，所有與內標物設定相關的選項，都保持預設值， 
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11. 使用優化軟體 Optimizer對質譜參數進行自動優化 

11.1 優化軟體的設置步驟  

   安捷倫 MassHunter Optimizer軟體，可以自動優化在 MRM模式下的母離子、Fragmenotr電壓，子

離子、碰撞能量。讓您的工作變得更加簡單。 

  運行 Optimizer前必須先打開資料獲取軟體，然後按兩下 圖示，打開優化軟體程式。 

  通過 File>New Project創建新的專案。 

 
  在 Optimizer Setup 頁面，需要設置樣品導入方式、Fragmentor 電壓的優化範圍、碰撞能量的優化

範圍以及用來優化的方法等參數。 

  
  Agilent推薦使用 Injection (with or without column)方式，並建議使用層析柱。如果不使用層析柱，

會造成化合物流出太快，有可能造成質譜採集的點不夠而得不到最優化的結果。 

  Fragmentor 電壓，填寫需要優化的電壓範圍進行粗優化（Coarse），並可以選擇進行精細優化

（Fine）。精細優化時，需要填寫步長（Step），軟體會在粗優化的結果上自動按照設定的步長加減

5步來進行進一步的精細優化（6495此處不可進優化）。 

  碰撞能量（Collision Energy），填寫碰撞能量的優化範圍。 

  Fragmentor和碰撞能量優化時，如果結果在設置的邊緣，需要更改範圍重新進行優化。 

在右側介面選擇優化時所使用的採集方法，以及優化時生成資料的存儲路徑。資料的存儲路徑一般

不需要改變。在空白處點擊右鍵，從彈出的功能表選擇 Add Method來選擇所使用的採集方法。 

注意：優化時，只是使用所選的採集方法的流動相比例、流速以及離子源條件。質譜的採集參數由

優化時上面所設定的範圍所決定，與採集方法本身的設置無關。 

 

 

  在 Precursor Setup頁面，設置母離子的一些限定條件。比如正離子還是負離子、不同條件下的離

子加合情況、離子的電荷數以及是否要設置特殊的排除離子等。 

 

優化時生成資料的存儲

路徑，一般不需要改變 
一般選擇此項 

設定 Fragmentor的優化範圍 

可以選擇精細優化，並設定步長 

如果 Fragmentor已知，可以使用 Fixed 

在優化完成後，選擇是否把儀器自動放到 Standby狀態 

碰撞能量的優化範圍 

多肽優化，一般選此選項 

添加採集方法 

設定加速電壓 
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  在 Product Ion Setup 頁面，必須設置截止質量。可以輸入一個截止質量數，也可以限定為母離子

的質量百分比。質量數（mass）低於設定值或小於母離子設定百分比的子離子將被忽略。 

 
  在 Compound Setup頁面，設定要優化的化合物的資訊。 

  右鍵在空白區域點擊，在彈出的功能表選擇 Add Compound。 

 
  彈出下面的表格，一般需要輸入的選項包括化合物的名稱、分子式或分子量以及樣品在自動進

樣器內的放置位置等。 

  一般化合物的分子式和分子量二者只要輸入一個即可。如果輸入化合物的分子式，軟體會自動

計算其分子量；如果不知道分子式，可以直接輸入其分子量即可。 

  注意：這裡是輸入的分子量，不是離子的質荷比。 

 

正離子一般選選加氫 負離子一般選選減氫 大部分小分子都帶一個電荷 

可以由用戶自行增/減 
如果需要排除離子，請設定排除條件 

可以輸入一個截止質量數，或設置母離子的質

量百分比，來限定最低允許的子離子質量 

如果需要排除離子，請設定排除條件 

化合物的名稱 化合物的分子式 

化合物的分子量 

樣品位置 

 

最多一次性可以優化 10個子離子，一般建議 2-4個 

進樣量的選擇 

進樣體積 

子離子掃描

的進樣因數 
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  進樣量可以選擇與採集方法中的進樣量一致或是指定進樣體積。優化時以指定的進樣體積（Inj 

Vol）進樣，當子離子掃描時，可以適當增加進樣量，PI Scan Inj Factor為指定進樣體積的倍數。 

 

  選中要優化的化合物，點擊 Start Optimizer 按鈕，開始運行自動優化。這時會彈出一個對話方塊

詢問 Do you want to start optimization?選擇 Yes，則開始自動優化過程。 

  
  在自動優化過程中，可以從 MassHunter 的採集軟體觀察運行情況，質譜的參數會根據設置不停

的自行變化。 

 
一般來說，自動優化包括下面幾步： 

1. 運行 SIM模式，自動變化不同的 Fragmentor電壓，優化得到最佳的 Fragmentor電壓。 

如果選擇了 Fine，還會在運行一次 SIM模式，進行 Fragmentor電壓的精細優化。 

2. 應用上一步得到的最優 Fragmentor電壓，運行子離子模式，施加不同的碰撞能量，得到化合物的子

離子列表。 

3. 運行 MRM模式，根據第 2步得到的子離子列表，對與所有的母離子-子離子的離子對施加不同的碰

撞能量，優化得到每個離子對最優的碰撞能量。 

4. 根據上一步優化的最優碰撞能量，運行子離子掃描，得到不同子離子的豐度強弱列表。 

 

 

必須選中要優化的化合物 

點擊此按鈕開始自動優化 
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5. 自動優化完成後，自動彈出下面的報告。包括優化的 Fragmentor，每個離子的最優碰撞能量。離子

按照豐度大小來排列，便於設置 MRM方法時選擇定量離子和定性離子。 

 
關閉 Excel 表格後，彈出下面的對話方塊，點擊 OK 完成自動優化過程。保存 Project。然後可以關閉

Optimizer軟體。 

 

11.2 已知母離子和子離子的化合物的優化軟體設置  

  對於母離子和子離子已知的化合物，可以直接設置好相關的資訊。這樣可以進一步加快優化過

程。 

首先，在化合物資訊欄上按一下右鍵，選擇添加方法(Add Method) 

 
然後再按一下右鍵，選擇添加離子(Add Precursor Ion)。 

 
  在母離子資訊行按一下右鍵，選擇添加子離子(Add Product Ion)。請輸入所有子離子的質量數資訊。 
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通過這種的方法，可以選擇固定的母離子、子離子，而只對裂解電壓和碰撞能進行優化。這樣

可以加速優化過程。 

 

11.3 將優化結果導入 MassHunter 採集軟體  

  我們可以在 MasssHunter 的採集軟體內將優化軟體得到的結果自動導入，生成 MRM 方法。具體

步驟如下： 

  在三重四極柱的採集頁面，將通過下拉清單選擇 MRM 的採集方式。然後在化合物設置表格內點

擊右鍵，從彈出的功能表選擇 Import from optimizer…。 

 
  然後會自動彈出 Database Browser視窗。找到需要分析的化合物，至少選擇一個定量離子，並建

議至少選擇一個定性離子。然後點擊 Import按鈕導入到 MassHunter採集軟體。 

注意：這裡離子是按照其豐度大小排列的。 

  如果你在 Optimizer 內運行過多個化合物的優化，這裡可以同時導入多個化合物；並且可以通過

限定過濾條件來隻顯示感興趣的化合物的資訊。 

 

從下拉清單選擇 MRM 

選擇 Import from 

optimizer 
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  這樣，Optimizer的優化結果就被自動導入到採集軟體，變成 MRM的採集方法了。 
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12. Masshunter Study Manager的使用 

12.1 什麼是 Masshunter Study Manager  

  Study是同組樣品和操作的集合。通過Masshunter Study Manager我們可以運行一個或多個Study。

我們可以簡單的理解為，序列的序列。 

  在桌面 Agilent Masshunter Workstation資料夾下面，找到 Study Manager的快捷方式，按兩下進入

Study Manager。 

 

 

 
 

 

點擊 Setting功能表，可以對 Study Queue進行設定，也可以設置 Script。 

 

 

 
 

 

 

12.2 提交 Study 

  點擊 按鈕，出現 Select Study Creator對話方塊，選擇 Worklist-Only， 

 

開始運行 Study序列 

停止運行 Study序列 

狀態顯示 

提交 Study 

LogBook 

手動鎖定採集軟體

和 Study Manager 

出現錯誤時停止運行

正在運行的 Study 會

自動進入完成列表 

自動鎖定軟體 
自動鎖定採集的資料 

添加 Script 當儀器處理

錯誤狀態和空閒時，需

要執行的動作。 

運行Study後 10分

鐘後儀器 Standby 

等待運行的 Study 已完成的 Study 

當前Study預

計剩餘時間 
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  選擇 Worklist檔，並給 Study命名， 

 
 

  樣品運行完成後，是否馬上進行資料處理或打列印報告（可以不選）， 

 
 

  最後，要導入的 Worklist列表，點擊 Finish，完成。 

選擇 Worklist檔  Worklist路徑 

Study命名 

分隔符

號 

Study存儲路徑   

操作人員 

是否進行資料處理   
資料處理方法 

是否生成報告   

 是否列印報告 

報告格式   
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  可以提交多個 Worklist，按提交的先後順序，進入 Pengding Study清單，依次運行。 

 
  最後點擊開始，運行 Study列表，運行過程中，可以繼續添加新的 Study進入到 Penging列表。 
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13. 使用 Source Optimizer對源參數進行優化 

  Source Optimizer軟體可以説明您優化離子源參數。 

  首先打開採集軟體，並調入已經優化好質譜參數的方法。然後，根據流動相的流速和比例，設

定源參數，做為初始參數。 

  在桌面上 Agilent Masshunter Workstation資料夾下面，找到 Source Optimizer的快捷方式。按兩下

進行 Source Optimizer軟體。 

 
  軟體預設調入的 Defaul.m，點擊 Browse，調入需要優化的方法。軟體會自動根據所選方法，調

出能夠優化的離子源參數。 

 

 
 

 

 

 

需要優化的方法    
專案的保存路徑    

項目名稱    

需要優化源參數  

 參數之間

等待時間 

 起始值  

 同參數不同設

定值間等待時

間 

 終止值  

 步長 

樣品名稱  

樣品位置 

每一針的 

重複次數 

 

創建方法  提交生成 study 關閉程式 

哪些參數

需要優化  

添加時間戳

記    

第一針做為校準樣

品，可用定量軟體

對結果進行比較 
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  優化從上到下依次進行，通過拖拽各個參數前面的藍色小方格，可以調整參數優化的順序。我

們建議優化順序，見上面兩個圖。有些參數，調用後需要平衡一會，比如說氣體流量，溫度，這些

參數注意設定 PreWait，有些參數，不同設定值之間需要的平衡時間也需要很長時間，比如說乾燥氣

溫度和鞘氣溫度。這些參數注意設定 StepWait。High Pressure RF和 Low Pressure兩個參數相互影響，

因此兩個參數會同時時行優化，不要單獨優化。 

 

  所有參數設定好後，點擊 Create Methods。此時軟體下方會提示，多少個方法生成，共多少 針進

樣，預計時間。注意，預計的時間不包含方法的後執行時間以及 PreWait和 StepWqit時間，僅為樣品

的執行時間。最後點擊 Summit，提交到 Study，運行 Study。 

 

 
 

  Study運行結束後，自動生成 Batch檔，打開定量軟體，打開在 Study下面的批文件，可以在定量

軟體裡，觀察結果。 
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14. 儀器的日常維護 

14.1 MS 維護週期表  

下表是安捷倫建議的維護週期。我們在現場培訓中無法涉及所有的內容。我們下面只講解最常用的

儀器維護操作。更多的維護操作，請參考補充學習資料部分。 

任務 推薦週期 

清洗離子源 每天 

檢查泵油液面 每週 

檢查質譜廢液桶 每月 

沖洗霧化器組件 每天 

清洗毛細管 3-6個月 

清洗光學元件（Ion Optics） 每年 

更換泵油 6個月 

更換氣體淨化管 每年 

更換噴霧針 1-2次/年 

注意：實際的更換維護頻次應該考慮實際的使用情況而定。 

 

14.2 清洗維護霧化器組件（Nebulizer）  

每天或一個批次的樣品運行結束後，可以使用 90%乙腈/10%水，設置泵的流量為２mL/min，把

質譜置於 ON的狀態，LC的流出的流動相切換到質譜，沖洗 Nebulizer三分鐘。 

90%乙腈/10%水是一個良好的通用沖洗溶劑，可以有效的除去霧化器以及質譜切換閥內痕量的

樣品殘留。但是，使用者也可能需要根據自己所分析的樣品和使用的流動相來調整沖洗用的溶劑及

其比例。比如，50%乙腈/50%水可以更有效的除掉殘留的鹽。 

當霧化器外表面比較髒的時候，最好的辦法是取下霧化器，使用合適的，可以充分溶解可能的

樣品殘留的溶劑來超聲清洗。 

注意：切記超聲清洗時不可使霧化器的尖端接觸到容器壁，否則可能會損壞噴霧針。 

比較簡單的辦法是直接用手拿著霧化器的頂部，使霧化器懸浮在溶劑中進行超聲。 

另外一個好辦法是往霧化器的頂部套一個小的移液槍槍頭（比如 200μL 的），然後剪掉槍頭的

尖端，把霧化器豎著放入燒杯超聲清洗。 

 

注意：超聲時注意溶劑不要沒過霧化器的根部。這裡有一個橡膠的 O圈，不可以浸泡在有機溶劑

中，否則會發生溶脹而無法使用。如有必要，超聲時可以把此 O圈拆下。 

O圈貨號 0905-1014 

 

14.3 每天清洗電噴霧霧化室  

操作時間 每天或每次輪班結束時，或是懷疑在從一種樣品到另一種樣品分析的轉換過程中存在

殘留物污染時。 
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所需工具 •乾淨的無塵布（Agilent部件號 05980-60051） 

•乾淨的手套 

•試劑級或更高級別的異丙醇 

•乾淨的沖洗瓶 

•HPLC級或更高級別的水 

所需零件 無 

注意： 殘留物應能溶解於所用的清洗溶劑。如果您不確定，可使用 50%異丙醇和 50%水的溶

劑混合液，這是一種效果不錯的常用清洗劑。 

1 準備好清洗溶劑。 

2 將儀器置於 Standby狀態。 

警告：離子源霧化室於高溫下作業，因此在清洗前應留出足夠的時間讓它冷卻下來。防止燙傷。

對於 AJS ESI，要注意鞘氣須降溫至 125℃以下，以防止加熱感測器壞。 

3 卸下霧化器。 

4 打開離子源。 

  

5 使用 50%異丙醇和 50%水的混合溶劑沖洗霧化室內部。 

6 用一塊乾淨的無塵布擦拭霧化室的內部，特別是噴霧擋蓋。 

7 沖洗噴霧擋蓋的周邊區域。 

注意：請勿直接對著毛細管末端沖洗，因為這會讓真空系統中的壓力大大增加。 

8 用流動相浸濕一塊乾淨的布。 

9 擦拭霧化護罩，噴嘴及其周邊區域。 

10 關閉離子源。 

警告：如果污染的症狀仍存在，或是噴霧擋蓋或毛細管蓋上有嚴重汙跡，無法通過常規的每天清

洗清除，則啟用每週清洗程式。 

  

噴霧擋蓋 

噴嘴 

擦拭清洗周圍 
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14.4 每週清洗電噴霧霧化室  

操作時間 每週一次，或是有症狀表明霧化室中存在污染物而通過常規的每天清洗無法除去時。 

所需工具 •細微性為 4000目的砂紙（部件號 8660-0827） 

•乾淨的無塵布（部件號 05980-60051） 

•棉簽（部件號 5080-5400） 

•乾淨的手套 

•HPLC級或更高級別的異丙醇 

•乾淨的沖洗瓶 

•HPLC級或更高級別的水 

所需零件 無 

注意：殘留物應能溶解於所用的清洗溶劑。如果您不確定，可使用 50%異丙醇和 50%水的溶劑混

合液，這是一種效果不錯的常用清洗劑。 

1 準備好清洗溶劑。 

2 將儀器置於 Standby狀態。 

警告：電噴霧霧化室於高溫下作業，因此應留出足夠的時間讓它冷卻下來。對於 AJS ESI，要注意

鞘氣須降溫至 125℃以下，以防止加熱感測器壞。 

3 卸下電噴霧霧化器。 

4 打開離子源並將其從 LC/MS上卸下。 

5 將離子源平放，並將潔淨的流動相或 50%異丙醇和 50%水的溶劑混合液倒入霧化室。 

 

6 使用乾淨的棉簽擦拭霧化室的內部。 

7 離子源繼續使用溶劑浸泡 15-30分鐘。 

在此期間，拆下噴霧擋蓋，毛細管帽及固定噴霧擋蓋的支撐環。用一塊乾淨的布用溶劑浸濕，

擦拭毛細管的末端、毛細管帽以，噴霧擋蓋及支撐環。如果比較髒，可以使用砂紙來打磨毛細管帽

和噴霧擋蓋及支撐環。注意：不可打磨毛細管。接下來將噴霧擋蓋，毛細管帽及固定噴霧擋蓋的支

撐環放到流動相中超聲 10分鐘，然後再用甲醇超聲 5分鐘，吹幹或在通風廚中晾乾，即可裝上。 

 

 

 

 

 

 

逆時針拆下

噴霧擋蓋 

拔出毛細管

帽 
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8 用裝有溶劑的清洗瓶沖洗噴霧擋蓋周邊區域。 

警告：切勿用溶劑直接噴入毛細管孔內！造成渦輪泵的負載急劇增大，容易損壞渦輪泵。 

 

 

 

 

 

 

 

9 用乾淨的布擦乾清洗的部件。重新裝好毛細管帽和噴霧擋蓋。 

注意：噴霧擋蓋上的孔請對準 12點鐘方向。如有必要，適當擰松擋蓋旁的兩個螺絲，將孔對準 12

點鐘方向後再重新擰緊。Jet Stream使用無孔的噴霧擋蓋；ESI/APCI/APPI/MMI使用帶孔的擋蓋。 

10 將浸泡離子源的溶劑倒掉。並用乾淨的布擦拭乾淨。 

11 將離子源重新安裝到儀器上。重新安裝霧化器，裝好離子源。  

14.5 卸下電噴霧霧化器   

操作時間 當需要對霧化器進行維護時。 

所需工具 乾淨的手套  

所需零件 無 

注意：殘留物應能溶解於所用清洗溶液。如果您不確定最近所用的流動相，可使用 50%異丙醇和

50%水的溶劑混合液，這是一種效果不錯的常用清洗劑。 

 

卸掉固定支

撐環的螺絲 

卸掉的噴霧擋蓋，毛細管帽及

固定噴霧擋蓋的支撐環 

周邊區域都可

以用溶劑沖洗 
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電噴霧霧化器 

1 將質譜切換到 Standby狀態。 

2 將霧化器上方的塑膠蓋滑開。 

3 斷開霧化器上段的 PEEK管，以及霧化氣體管線與霧化器的連接。 

4 沿逆時針方向旋轉霧化器，直到它脫離固定螺絲。垂直上提，輕輕取出霧化器。 

警告：霧化器末端可能會很燙，因此在拿之前要先讓它冷卻下來，防止燙傷。 

 

14.6 調整電噴霧霧化器針位置  

下面以 ESI的霧化器並用舊的噴霧器支架為例來說明，其他離子源的調節步驟類似。 

需要的工具：25X 放大鏡、霧化器調整底座、1.5mm 內六角螺絲刀、T6 螺絲刀、3mm開口扳手、

7/16-9/16英寸開口扳手。 

1. 把霧化器至於調整底座上，調節放大鏡的焦距至可以清晰的觀察到噴霧針的尖端。 

 

2. 對於新型的霧化器（備件號 G1958-60098或 G1946-67260），根據所用固定螺絲的不同，用 1.5mm小

內六角螺絲刀或 T6的星形螺絲刀鬆開噴霧針固定螺絲。 

 

 

 

 

  

如果是舊款的霧化器（備件號 G1946-60098），請使用 3mm 和 7/16 英寸開口扳手如左下圖鬆開

固定螺絲。新舊型號的霧化器可以根據頭部角度的不同來區分。 

 

 

3. 使用隨機帶的 3mm的扳手調節噴霧針的位置，直到噴霧針恰恰露出噴霧器的頂端。 

 

新型霧化器 G1958-60098 

或 G1946-67260 

舊型霧化器 G1946-60098 

1.5mm  T6 
T6 1.5mm 
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4．重新擰緊噴霧針固定螺絲。重新把霧化器安裝到離子源上。 

注意：請勿讓霧化器的末端碰到任何物體。針伸出的霧化器尤其脆弱。哪怕有一點損壞都會嚴重

影響系統性能。 

下面以 ESI的霧化器並用新的噴霧器支架為例來說明，其他離子源的調節步驟類似。 

需要的工具：LED 手電筒、新型霧化器支架、40 倍放大鏡、1.5mm 內六角螺絲刀、T6 螺絲刀、

3mm開口扳手、7/16-9/16英寸開口扳手。 

1. 把霧化器、手電筒及放大鏡按下圖所示至於支架上，如觀察噴針伸出霧化器長短按左圖所示安放，

如觀察噴針是否在霧化器尖端中心位置按右圖所示安放，調節放大鏡的焦距至可以清晰的觀察到噴

霧針的尖端。 

 

 

 

 

 

 

2. 對於新型的霧化器（備件號 G1958-60098或 G1946-67260），根據所用固定螺絲的不同，用 1.5mm小

內六角螺絲刀或 T6的星形螺絲刀鬆開噴霧針固定螺絲。 

 

 

 

 

  

如果是舊款的霧化器（備件號 G1946-60098），請使用 3mm和 7/16英寸開口扳手鬆開固定螺絲。 

3. 使用隨機帶的 3mm的扳手或 7/16英寸開口扳手調節噴霧針的位置，直到噴霧針恰恰露出噴霧器的

頂端（0.003英寸）。同時觀察噴針是否在霧化器中心位置，如下圖所示。 

 

 

 

 

 

 

 

 

LED 

手電筒 

放大鏡放此位

置觀察 ESI 噴

針，另外一個

孔可觀察

APCI噴針 

霧化器 

霧化器 LED手電筒 

放大鏡 

1.5mm  T6 
    T6 1.5mm 
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4．重新擰緊噴霧針固定螺絲。重新把霧化器安裝到離子源上。 

注意：請勿讓霧化器的末端碰到任何物體。針伸出的霧化器尤其脆弱。哪怕有一點損壞都會嚴

重影響系統性能。 

 

14.7 機械泵的日常維護  

MS40的機械泵具有內迴圈的功能，所以不需要管理泵的回油問題。但要定期檢查並更換泵油。 

 

 

 

 

 

 

 

 

 

 

 

每半年或當機械泵內的油位偏低時，可以把儀器放空後把舊的泵油倒淨，添加１升新的泵油。

注意必須添加正確的泵油型號，否則，可能影響儀器的性能，甚至損壞機械泵。MS40 機械泵使用的

是 AVF60M（或 SW60）型號的泵油，備件號：6040-1361。 

這個操作需要把儀器放空，關閉電源後進行。擰開加油蓋，添加適量的泵油，至油位接近上限

位置。但是不可超過，否則儀器操作時可能會有多餘的泵油從廢氣管噴出。 

14.8 檢查廢液桶  

每月或檢查質譜廢液桶。當廢液桶內液體比較多時，及時把多餘的溶液倒掉。 

注意，請不要使廢液桶的排氣管被其他物體壓住，造成離子源內排氣不暢，也不建議將廢氣管

放入萬象罩內排廢氣。 

 

 

14.9 氮氣發生器的維護  

如果使用者使用氮氣發生器的話，請務必週期性的維護氮氣發生器。請諮詢您所使用的氮氣發

生器的廠家來確定維護的週期，主要的維護操作可能包括注意冷凝水的排放，以及定期更換氮氣發

生器的氣體過濾裝置。 

注意：由於氮氣發生器以環境空氣作為氣體來源，所以其他過濾裝置必須定期更換。否則過濾

裝置失效後，會把環境空氣中的有機污染物通過乾燥氣和霧化器進入質譜，嚴重影響儀器的性能，

降低靈敏度和重現性。使用氮氣發生器的使用者，強烈建議每半年到一年更換乾燥氣的氣體淨化管。

安捷倫部件號為 BMSN-4。 

MIN是最小液位 

放油口 

加油口 
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14.11 更換液氮時的注意事項  

如果您更換液氮時，只是使用另一個充滿液氮的液氮罐來替換空的液氮罐的話，那麼這種更換

只要幾分鐘就可以完成。建議您只要把儀器放在 Standby（如果是使用帶有 Agilent 噴射流技術的 ESI

源的話，請您把儀器置於 Standby，並待鞘氣溫度降低到 125 度之後再操作），就可以直接更換液氮

罐了。 

如果您是現場往空的液氮罐內充液氮的話，那麼這個過程需要較長的時間。建議您最好準備一

個氮氣鋼瓶（普氮或高純氮均可），把儀器放到Stanby，在液氮罐充氮的過程中使用這個氮氣鋼瓶來

給質譜供應氮氣。 

當您在發現液氮用完，又不能馬上更換新的液氮罐時，您也可以臨時使用氮氣鋼瓶來供應氮氣。 

但如果您不能馬上更換液氮罐，又沒有氮氣鋼瓶可用時，我們建議您最好把質譜 Vent 後關掉電

源，待液氮準備好後再重新開機。防止由於沒有氮氣的保護而造成環境空氣直接大量抽入質譜內部，

污染質譜，並可能損壞質譜。 
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15. 安捷倫售後服務流程 

15.1 0800 電話報修方案  

售後服務中心免費電話：0800018768 

免費傳真：0800026369 

電子信箱：lsca-taiwan_ccc@agilent.com 

第一線客服人員會紀錄儀器序號 問題及聯絡方式 

如果是 LC GC 有可能會直接幫您解答 無法解答會轉給相關客服 兩小時內會回您電話 

 

 

 

15.2 安捷倫售後服務 Line@ 

 

 

Lineid: @agilent         
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附錄 

附錄 1 離子源參數快速參考指南  

附錄 1.1 電噴霧源 (ESI) 

HPLC流速 霧化器墊片* 霧化氣壓力 

Nebulizer pressure 

乾燥氣流速 

Drying Gas Flow 

乾燥氣溫度 

Drying Gas Temp 

毛細管電壓 

Capillary Voltage 

1-10 μL/min 不安裝  15-20 psi 4 325℃ 4000（正） 

3500（負） 10-50 μL/min 不安裝  15-20 psi 5 325 ℃ 

50-200 μL/min 安裝  20-40 psi 8 350 ℃ 

200-500 μL/min 安裝  30-50 psi 8-10 350 ℃ 

500-1000 μL/min 安裝  50-60 psi 10-12 350 ℃ 

*注意：霧化器墊片預設已經安裝在儀器上。 

一般 HPLC的流速在 200 μL/min左右時可以得到最大的靈敏度。 

 

附錄 1.2帶有 Agilent噴射流技術的 ESI源(Jet Stream) 

推薦的起始參考條件如下： 

參數 推薦值 

HPLC流速 250-600 μL/min 

鞘氣溫度 250C 

鞘氣流速 11 L/min 

噴嘴電壓 500 V 

霧化器壓力 45 psi 

毛細管電壓 
4000 V (pos) 

3500 V (Neg) 

乾燥氣流速 5 L/min 

乾燥氣溫度 300 ℃ 

一般 HPLC的流速在 250-600 μL/min之間時，儀器可以達到最佳的靈敏度。 

對靈敏度影響由大到小依次是：鞘氣的溫度和流速，噴嘴電壓，霧化氣壓力，毛細管電壓，乾

燥氣溫度和流速。 

 

附錄 1.3 大氣壓化學電離源（APCI） 

HPLC流速 

μL/min  

霧化氣壓力 

Nebulizer pressure 

乾燥氣流量 

Drying Gas Flow 

乾燥氣溫度 

Drying Gas Temp 

蒸發器溫度 

Vaporizer Temp 

電暈電流 

Corona Current 

毛細管電壓 

Capillary Voltage 

200-1500  60 psi 4-6 L/min 350 ℃ 300-500 ℃ 
4μA(正) 

2 0μA(負) 
3500 V 

與 ESI不同，APCI 需要足夠的液體流量以得到最佳的離子信號。一般來說，500 μL/min 的流速會

得到比 200 μL/min的流速更高的靈敏度。需要通過實驗來確認所分析物質的最佳 HPLC流速。 

對於 APCI來說，甲醇是比乙腈更好的溶劑。 

蒸發器溫度需要根據使用的溶劑，HPLC 的流速以及所分析的具體物質做進一步的優化。最佳的

蒸發器溫度與所分析的物質相關，難揮發的物質需要更高的溫度。 
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附錄 2 不同調機液離子列表  

安捷倫的 LC/MS主要用到下面幾種調機液。各種調機液中包含的離子列表如下： 

ESI調機液，備件號 G1969-85000 

 Positive Negative 

Mass 1 118.086255 112.98587 

Mass 2 322.048121 301.998139 

Mass 3 622.028960 601.978977 

Mass 4 922.009798 1033.988109 

Mass 5 1221.990637 1333.968947 

Mass 6 1521.971475 1633.949786 

Mass 7 1821.952313 1933.930624 

Mass 8 2122.933152 2233.911463 

Mass 9 2421.913990 2533.892301 

Mass 10 2721.894829 2833.873139 

 

APCI/APPI-L調機液，備件號 G1969-85010 

 Positive Negative 

Mass 1 121.050873 119.036320 

Mass 2 322.048121 316.013789 

Mass 3 622.02896 655.991085 

Mass 4 922.009798 955.971923 

Mass 5 1221.990637 1255.952761 

Mass 6 1521.971475 1555.933600 

Mass 7 1821.952313 1855.914438 

Mass 8 2121.933152 2155.895277 

 

 

MMI調機液，備件號 G1969-85020 

 Positive Negative 

Mass1 121.050873 112.985587 

Mass2 322.048121 301.998139 

Mass3 622.028960 601.978977 

Mass4 922.009798 1033.988109 

Mass5 1221.990637 1333.968947 

Mass6 1521.971475 1633.949786 

Mass7 1821.952313 1933.930624 

Mass8 2121.933152 2233.911463 

Mass9 2421.913990 2533.892301 

Mass10 2721.894829 2833.873139 
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附錄 3 毛細管的維護  

附錄 3.1 導電毛細管的清洗步驟，備件號 G1960-80060 

對於快速切換導電毛細管，我們推薦下面步驟清洗，此步驟也可適用於非導電的透明毛細管。 

 

需要的工具：Alconox清潔粉末（隨新儀器附帶），100 mL量筒，天平，超聲清洗儀等。 

1. 稱取一克 Alconox清潔粉末置於 100 mL潔淨的量筒中(建議使用聚丙烯量筒)， 用高純水充分溶解。  

2. 如果使用聚丙烯量筒的話，可以直接將毛細管放入量筒中。如果使用玻璃量筒的話，請將毛細管

兩頭用 1 mL 的移液槍槍頭套住，並將槍頭前端剪去如下圖所示。這樣可以保護毛細管在超聲清洗

的時候不會直接碰到玻璃量筒壁，防止毛細管破碎。 

 

3. 將毛細管豎直放入充滿 Alconox 溶液的量筒中，確保液面沒過毛細管。超聲清洗 10min。如果液面

無法沒過毛細管的話，請適量添加一些高純水。 

 

4. 拔掉移液槍槍頭，用高純水沖洗毛細管。  

5. 用一個 1mL 的移液槍頭緊緊套住毛細管的一端，然後用注射器抽吸高純水，拔掉注射器針頭，通

過移液槍頭處沖洗毛細管內壁。反復多次，以確保清洗劑充分沖洗乾淨。  

 

6. 重新安裝毛細管，開機。使用異丙醇潤滑毛細管外表面，會使毛細管更容易插入。 
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附錄 3.2 絕緣透明毛細管的清洗步驟，備件號 59987-20040 

 

 

這種毛細管可以用上面的步驟進行清洗。也可以遵循下面的步驟進行清洗。 

需要的工具：棉簽，用於毛細管清潔的金屬絲（備件號 G1946-80054）等。 

1. 用異丙醇或甲醇/水溶液濕潤清洗毛細管內壁。 

 

2. 截取約 50釐米長的金屬絲，把兩端重疊在一起，小心穿過毛細管。直到只剩最後一小圈在外面。 

 

3. 用一小團脫脂棉穿過鋼絲圈。注意，注意棉花團不要太大，必須保證其可以順利穿過毛細管。否

則金屬絲可能被拉斷而棉花團堵塞在毛細管內，很難去除。 

 

 

4. 用異丙醇或甲醇/水溶液潤濕小棉花團，然後小心的慢慢拉金屬絲，使棉花團穿過毛細管。 

5. 如果發現棉簽很髒，可以重複 1-2次，直到棉簽完全乾淨為止。 

6. 重新安裝毛細管，開機。使用異丙醇潤滑毛細管外表面，會使毛細管更容易插入。 
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附錄 4  質譜常用消耗品  

備件描述 備件號 

調機液，ESI-L G1969-85000 

調機液，APCI-L G1969-85010 

Agilent MS40+前級泵油，1L/瓶 6040-1361 

霧化針組件，ESI 
注1 G1958-60136 

霧化針組件，ESI （早期的霧化器）注2 G1946-68703 

霧化針組件，APCI/APPI G1946-68704 

砂紙，4000目，1張/包 8660-0827 

砂紙，8000目，1張/包 8660-0852 

棉簽，100支/包 5080-5400 

無塵布，15片/包 05980-60051 

綜合捕集阱，乾燥氣用 RMSN-4 

水分捕集阱，乾燥氣用 BMT-4 

綜合捕集阱，碰撞氣用 RMSN-2 

離子傳輸毛細管，可用於G6420A,G6460C,G6470A 59987-20040 

離子傳輸毛細管，G6420A,G6460C,G6470A G1960-80060 

離子傳輸毛細管，G6495A G1964-80659 

電子倍增器，用於三重四極柱質譜 G2571-80103 

毛細管彈簧，Spring, canted coil (for capillary cap)，1個/包 1460-2571 

用於毛細管清潔的金屬絲 G1946-80054 

1/4英寸聚四氟乙烯管，5米長 G1946-80078 

1/4英寸聚四氟乙烯管，每釐米 
注3 0890-1793 

注 1：所有的帶有安捷倫噴射流技術的 ESI源，均使用此種霧化針元件。 

下表中的離子源，在所列的序號之後的產品，也使用此種霧化針元件。 

離子源類型 序號 

G1948A US91801994 

G1948B US91201787 

G1978A US90800804 

G1978B US90700787 

G3251A US91200355 

G3251B US91200355 

注 2：上表中的離子源，在所列的序號之前的產品，均使用此種霧化針元件。 

兩種霧化針的尺寸規格不同，不可混用。 

注 3：這裡列的備件號對應的是一釐米長的 1/4英寸聚四氟乙烯管。比如我們想訂購 10米長的聚四氟

乙烯管的話，則應該訂購 0890-1793*1000。 
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附錄 5 儀器配置 Instrument Configuration  

如果儀器無法正常連線，或者需要更改儀器的配置，可以使用 Instrument Configuration 程式重新

配置儀器。 

注意：如果我們配置的是 HPLC+QQQ儀器，在 HPLC的電源不打開的情況下，軟體會無法連線。 

按兩下桌面的 圖示。打開 Instrument Configuration 工具。如果彈出下面的提示框，則表示

還有採集的後臺進程沒有完全關閉。 

 

請確認採集軟體已經關閉，右鍵點擊桌面右下角狀態列上的 圖示，在彈出的窗口點擊

Shutdown Engines，等待桌面右下角狀態列上的圖示變為 後，就可以運行 Instrument Configuration

程式了。或者在採集軟體關閉後，按兩下桌面的 來自動關閉所有的後臺進程。 

 
 

預設 LC/MS 系統，需要同時勾選質譜和 HPLC，但是如果想只連接 HPLC 或質譜，可以只勾選相

應的選項。 
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是否配置 HPLC。

如 果 只 連 接 質

譜，不選此項 

點此按鈕來查看

和更改HPLC的詳

細配置 

是否配置質譜。

如 果 只 連 接

HPLC，不選此項 

QQQ請選此選項 



 

版權所有  影印必究 

 

在自動進樣器的配置選項中，大部分使用預設值即可。但是，如果配備了自動進樣器的恒溫器

或者 Flexible Cube，需要設置相關的選項。 

 

對於泵，可以設置所使用的壓力單位，是否安裝了 Seal Wash裝置。對於 1290，需要選擇所使用

的混合器。 

 

如果配備了自動進樣器的恒

溫器，請勾選相應的選項 

如果配備了 Flexible Cube，

請勾選相應的選項 

是否安裝了 Seal Wash 

置所使用的壓力單

位，可選 Bar或者 psi 

對於 1290，選擇所

使用的混合器 
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對於柱溫箱裝作，需要設置是否安裝了閥，以及所使用的閥的類型。 

 
DAD檢測器沒有需要設置的地方。 

 
所有的模組都設置完成後，點擊 OK 按鈕返回上一級頁面。然後再次點擊 OK 按鈕。儀器配置完

成後，會彈出下面的提示視窗。點擊 OK按鈕。採集軟體就可以使用了。 

 

  

需要設置是否安

裝了閥，以及所

使用的閥的類型 
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